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¢Qué es Mendeley?
Es un gestor bibliografico que combina una plataforma web con una version de escritorio y que facilita
la captura y organizacion de la informacién bibliografica, asi como el trabajo con los documentos y la

cita y creacién de bibliografias en maltiples estilos bibliograficos.

Ademas es un sistema que permite gestionar y compartir documentos de investigacién, combinando
una aplicacion de gestion de documentos PDF y de gestion de referencias con una red social online
para investigadores, permitiendo crear grupos de trabajo publicos y privados, crear contactos y

descubrir referencias bibliograficas incorporadas por otros usuarios.

Creacion de una cuenta y Acceso a Mendeley

Para crear una cuenta de Mendeley sélo hay que acceder a la web http://www.mendeley.com y pulsar

en [Create a free account|, completamos los datos basicos que nos solicitan y automaticamente

tendremos nuestra cuenta en el sistema.

Recomendamos crear la cuenta utilizando un correo institucional, es decir los acabados en
@uca.es o @alum.uca.es ya que asi podremos tener las condiciones de las cuentas

institucionales de Mendeley.

AR Mendeley Signin  Create account | Dow |

Reference Management  Research Network  Datasets  Careers  Fi Q Search

Empowering resea c‘her
to connect and inspire §

Create a free account

Reference Research network Datasets Careers
management
Connect and collaborate Store, share and cite your Search for science and
Read, organize and cite all with millions of researchers datasets with ane secure technology jobs in
of your research from one worldwide. online repaository. institutions worldwide.

librarv.
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Create a Mendeley account

One account for all your research.

de Biblioteca

http: / /biblioteca.uca.es

Hi Jesus!

Let's complete your public profile.

Field of study

Academic status

By clicking Create account, | agree to the Privacy Policy and Terms & Conditions

Create account »

La Biblioteca de la Universidad de Cadiz ha contratado la versién institucional de Mendeley para

mejorar las condiciones de las cuentas de los usuarios de la UCA, las condiciones de las cuentas

institucionales son las siguientes:

Benefits for Researchers
Cite and Reference
Read and Annotate

Mendeley Suggest

Mendeley
(Freemium)

Mendeley Institutional Edition
(Paid for Services)

Yes Yes
Yes Yes
Yes Yes

Biblioteca de la Universidad de Cadiz

Pag. 5 de 59



% lC | Universidad . . e
=7 U de Cadiz Area de Biblioteca http://biblioteca.uca.es

Data repository Yes Yes
Personal Library storage space 2GB 100GB
Shared Library storage space 100MB 100GB
# Private groups 5 Unlimited
Private group size 25 100

Benefits for Institutions

Custom designed user awareness and adoption No Yes

program

Institutional Homepage No Yes

Usage Analytics No Yes

Link resolver integration No Yes

Alumni Policy No Yes

Customer Support Service Via Online Through Elsevier OSCS and Online,
only 24/5

Para disfrutar de las condiciones de la versidon institucional el usuario solo debe crear su cuenta desde
un ordenador que tenga en ese momento una IP de la Universidad de Cadiz. Es decir, conectado a la

ted de la UCA o utilizando VPN desde fuera. Instrucciones VPN: http://informatica.uca.es/vpn-uca/

De esta forma, Mendeley nos incluye automaticamente en el grupo institucional de la UCA. Podemos
comprobarlo, simplemente, visitando la web del grupo, pulsando en el siguiente enlace:

https://www.mendeley.com/groups/6955431 /universidad-de-cadiz/ o buscando “Universidad de

Cadiz” en el buscador de grupos.

El usuario mantiene esta version institucional siempre que acceda a Mendeley al menos una vez cada 12

meses desde una IP de su institucion.

[ https://service.elsevier.com/app/answers/detail/a_id/26125/kw/institutional/supporthub/mendeley/ |
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M Feed  Library  Suggest Stats Groups Data % BcaCPR . A

Papers Peo pport

Q) Universidad de Cadig|

Groups

In this catalog: 184,878 public groups Create a new group

Universidad de Cadiz B

eqg: Social networks

Groups 1 - 20 of 10,997 / Prev4 1 2 3 550 » Next

Universidad De Cadiz ANSTITUTION
Cuenta institucional de la Universidad de Cadiz, que permite a sus miembros
disponer de mas espacio personal (5GB) y compartido (20GB), asi como la...

&

Q)
>

Doctorado -Universidad nacional de Piura
Doctorado -Universidad nacional de Piura

__3,,9 Join group ;i Follow group 1 paper 3 members

Feed Library Suggest Groups Datasets Careers Funding Q, Search ém 1esus‘v

Cuenta institucional de la Universidad de Cadiz, que permite a sus miembros disponer de mas espacio
personal (5GB) y compartido (20GB), asi como la creacion de un ndmero ilimitado de grupos de hasta 25

&R

INSTITUTIOMNAL GROUP 2659
\% Universidad De Cadiz members
UCA

‘Jniversidac miembros, y otras ventajas institucionales. Si usted pertenece a la UCA, (inase a este grupo.
‘a Cad
Members
X

Group Owner
Welcome to the Mendeley Institutional Edition!
== Biblioteca ...
Good news, because your institution subscribed to the Institutional Edition you will ‘
receive the following premium benefits:

+ 100GB of personal and shared storage

+ Unlimited groups with up to 100 collaborators
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Descarga e instalacion de Mendeley Desktop

Al crear la cuenta, automaticamente se descarga el software instalable, la versién de escritorio, en
nuestro ordenador. Si no se descarga o debemos descargarla para instalarla y ya tenemos cuenta

podemos hacerlo en: http://www.mendeley.com/download-mendeley-desktop, para los sistemas

operativos: Windows, Mac y Linux.

M Feed Library Suggest Stats Groups Q Search BcaCPR ~ v

Download Mendeley Desktop for Windows

Save time managing PDFs, instantly share thoughts on papers with colleagues and Mendeley Desktop for other systems
automatically back up and sync your files between different computers.

-
“ Mendeley Desktop for Mac OS X 10.6+

A Mendeley Desktop for Linux

U Download Mendeley Desktop Mendeley for iPhone, iPod Touch and iPad
Opens in the iTunes App Store

Latest version for Windows XP or later See release notes
Current Development Preview

Explore new features currently in development and provide
. Letresearch fall into place us with feedback: download the current development
Automatically collate. organise and manage your PDFs using folders. tags, filters preview
and full text search. More...

=y Your ideas with your papers

i effects Add highlights and sticky notes inside your PDF as you read them, and privately
¢ on iue share them with colleagues. More

Generate citations in seconds
w Insert references from your research library and generate bibliographies on the fly

More..

Una vez instalado, al abrir el programa, este nos invita a incorporar los documentos que tengamos en el
ordenador, nos muestra referencias populares en nuestra area y nos permite también hacer una
bisqueda con nuestro nombre para incluir nuestras publicaciones. Todas estas opciones son optativas y

se pueden realizar posteriormente, si desea saltarlas debe pulsar en [Skip]

Al abrir el programa finalmente, veremos una pagina de bienvenida donde nos invitan de nuevo a
incluir los documentos pdf que tengamos ya recopilados o a trasladar la informacién bibliografica desde

otros gestores de referencias. Veremos cémo llevar a cabo estas acciones en los siguientes apartados.
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Mendeley Desktop

File Edit View Tools Help
Ll~l & | 0= | =2
Add Files Folders Share

( Q= Search...

Mendeley
@ Welcame to Mendeley
4~ Literature Search
Iﬂ Mendeley Suggest

My Library
1l All Documents
\_‘;, Recently Added
Ll_i_J Recently Read
i Favarites
_2_ My Publications
[ Unsorted
~ || carpeta Prueba
|L subcarpeta
|| Open Access
Create Folder...

Groups

> B Grupo Pruebas Privado
|IA Grupo Prueba Publico
4l Artificial Intelligence:

Add papers to get started

or import from

Endnote ‘ Zotero ‘ Refworks ‘ Other...

Tools B tips

Read our Getting Started Guides to get up and running with
o ] Mendeley. Learn how to add and organize your docurments,

i read and annotate your papers, and cite research as you write,
4| Emotion Regulation Getting
4l Software Process Improvement & Fo... - Started Getting started with Mendeley
[ Filter by Authars -
Al

Note: Mendele not move or delete your existing files or folders.

El programa se estructura en base a tres columnas de informacion:

e La columna lateral izquierda contiene las formas de acceder a las referencias.

o [.a columna lateral derecha la informacidn de la referencia seleccionada

e .a zona central contiene las referencias de nuestra cuenta.

Biblioteca de la Universidad de Cadiz
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File Edit View Tooks Help
Q-] | G @ =2
Add Files Folders Related  Share  Sync Search
Mendeley =] All Documents
- Literature Search
I Mendeley Suggest *|® B Adthors Title Year PublishedIn Added Details | Notes | Contents | Emichments |
g de Granda-Orive, José Igna... El movimiento Open Access: éoportunidad para re- 2015 Archivosde  12:55pm . 4
My Library e m evaluar el proceso de revisién por pares (peer revie Sronconeumol Type: [Journal Artde =)
5] Al Documents a Dimou, Anastasia; De Vocht... Visualizing the Information of a Linked Open Data 2014 Proceda 12:51pm The role of open access and
D Recenty Added Enabled Research Information System Computer 5 open educational resources: A
L Fovorites o Etchichury, Horacio Javier; P... Global forces and local currents in Argenting's scence 2014 Athenea  12:51om distance learning perspective
‘6' policy crossroads: Restricted access or open know.. Digital o
Authors: S, Hatzipanagos, J. Gregson
& My Publicationss . Forques, Bernard; Liarte, S¢... Academic publishing: Past and future 2013 Management 12:51om panag E
(& unsorted (France) A2 View research catalog entry for thispaper | |
4 ] Carpeta Doctorado o @ Garca-Algar, Oscar; Vall Co...  Publicaciones cientificas: Presente y future 2013 Archivosde  12:56pm —
|1 subcarpeta Doctorado - Broncaneumal Journal: - Flectronic Journal of e-Learm..
I} Open Access - Hatzipanagos, Stylianos; Gr. The role of open access and open educational 2015 Electronic 12:50pm Year: 2015
h resources: A distance learning perspective Journal of
Create Folder.. Volume: 13
. Karlsson, Nikias The crossroads of academic electronic avalabiity: 2014 Current 12:51pm
Groups How well does Google Scholar measure up against Science Issue: 2
& Grupo Pruebas Privado o @ LépezTorres Hidaigo, Jests  Habitos de lecura de revistas cientifias enles 2011 Atendon 12:56pm Pages:  96-104
médicos de Atencidn Primaria Primaria
{8 Grupo Prueba Publico -
Hl 4 . Matutinovic, Stela Filipi Open access in botany 2014 Botanica 12:51pm Abstract:
4| Emotion Regulation Serbica The paper explores the role of Open Access (in
Creste G " licensing, publishing and sharing research data)
reate Group... . Prost, Héléne; Schapfel, Joa... Degrees of Openness: Access Restrictions in 2014 D-Lb 12:51pm 3nd Open Educationsl Resources within Distance
Institutional Repositaries Magazine Education, with a focus on the context of the
University of London International Programmes,
Trajh - Rizor, Sara L.; Holley, Rober. gpen :CLISS ?EI;RE;E&F&;“;‘%EE%EHd G‘u[\;i 2014 ;z;urTa\‘ufp 12:50pm We rEDotrvt on a case study where dEngErE
2 Al Deleted Documents pen Access Are Meeting (or Mot Their Grigina! Go olarly Pu gathered from librarians and programme
— directors relating to existing practice around
Open Access; the major constraints in using
Open Educatonal Resources and the main
L resource implications, when adopting Open
de Granda-Orive, José Ignacio Educational Resources, were also investigated.
De Vocht, Laurens Our &im was to (3) raise awareness and
| understanding of what is possible to achieve in
EL";“& A"asfs'a | higher education by embracing the Open Access
; ; “"'E’ ”’a:" avier movement {b) identify next steps and actions t. i
orgues, Bernar

1] 1 of 11 documents selected

Version web de Mendeley

Mendeley sincroniza las referencias de nuestra cuenta entre la versioén de escritorio (Mendeley Desktop)

y la version Web, ademas de con las versiones moviles, para forzar la sincronizaciéon sélo debemos

pulsar en [Sync]

La version web nos ofrece diferentes opciones

funcionalidades de Mendeley Desktop.

et

Welcome to Newsfeed!

Feed

Library

Suggest

Stats Groups

Mendeley is improving and your feed is evolving with it. Check this space regularly for updates on your

network and to find relevant articles. More to come in the near future.

%) Nostalgic? Visit the old feed
74 Tell us what you think

Application of artificial intelligence for optimization in pavement management

Salini R, Xu B, Lenngren C

International Journal of Engineering and Technalogy Innovation (2015)

+ Save reference

@ Rews SALINI has added a document to Artificial Intelligance group - February 27

12 Share to your followers

Q, Search

Install the Web Importer

The Web Importer lets you

BeaCPR ‘ v

import references and

documents from over 30

academic databases.

+ Add it to your browser

Articles suggested for

you

We've personalized article
suggestions from our catalog

based on your Mendeley

activity.

@ See suggested articles

que iremos viendo, que complementan

las
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Importar metadatos directamente desde el documento PDF

Es la forma mas comun de importar documentos a Mendeley, sélo debemos seleccionar los archivos en

nuestro ordenador y Arrastratlos y soltarlos en el programa. La alternativa al sistema de arrastrar y

soltar es pulsar en [Add Files] y seleccionar los archivos a importar.

Al importar directamente los pdf, el programa reconoce los metadatos del archivo y los coloca en el

registro de la referencia en la columna lateral derecha.

NOTA: No siempre los archivos pdf contienen correctamente los metadatos, es conveniente revisar
que los datos hayan sido correctamente importados y si no es asi modificar los erréneos y completar los

inexistentes. Los datos que Mendeley volcara en la bibliografia al citar, los extrae de este registro, por

tanto deben ser correctos para evitar que la bibliografia contenga errores.

F e

File Edit View Tooks

Help
o=l | B - a | | [+}
Add Fles. Folders. Reistrd  Share Syre

I* & W Authors

= All Documents | Fdt Settngs.

Title

 Jost Igra.. B o Open Accews;
evalusr e proceso de révisdn por pares (Deer revie...

cht. Visuskeng the Inf £

Enabled Revearch Infurmation Systes

Bobal furces and local arrents in Argenting's sierke
Doky crossroads: Restncted sccess or open knowl
Academic publishing; Fast and future.

... Publicadones ceniificas; Presente y fulro

\ resources: A detarce iy pespecive

The wossrvads of scadenc seclrons svalabily:
well does Coagle Schelor measmre up aganst

e Aberciin Primaria

el

V4 h ra
L subcarpets Doctorade -
. e e .
Crmate Fukler
— . Karksson,
— Groups
- — [ Ir L —— - m Ldpez
— LBl Grupo Prusha Pubin o
— B cooson feguanon .
Create Group... S
Trash =
i 4 Delebed Documents
WEMD‘S 1

L | 2
e Granda Crve, Josd igradn

De vocht, Laurens

Dmou, Anastass

Etchichury, Horsco Javier

Forgues, Berrard -

I} 1 ot 11 dusuments selected

of Cpenness: Atoess Restricions in
tutronal Repsitones

Access Gosle Revisted: How Green and Gokd
Aceess Are Meesng (er Not) Their Original Go

Year Publishedin Added
015 Achivesde  1Z:56om
Bronconeuma

14 Proceda 1:51om
Comonter 5.

2014 Athenea
(=

2013 Management

(France]

013 Archives de
Bronconeumal

2015 Bectronic

Jounsof ...

014 Current
Srierer
2011 Atencien
Primaria
014 Bularica
Serhica
M14 Dk

1% Jounal of
Schalarty Pu

1:5tpm
1z5iom
12:560m
L=50pm
LS tpm
12:5%0m
15 tpm
1245 1pm

Delsk [ hotes | Contents | Evidmens

Trve: | Jeumal Artide =) (3

The rule of open access and
open educational resources: A
distance learning perspective
authors: 5, Hatzipanagos, J. Gregson
AR View 1ewmirch calialog entry bor Sis paper
Joanas ERetron o of e Learnd.,
2015
volme: 13

| e 2

i 96104
Abstract:

The paper riplares the rele of Cpen Acress (n
kg, bkl ana shariy revear ch data)

Education, with a focus un the wontext of the

Uriuersity of Londan Tntermational Programmes.

\We report on & cave shudy where dals were

gathered from lbrarians and programme

drectors relalng lo exilig oracioe sroud
Acerss: the

underslanding uf whal & possbie to adveve n
education by embraang the Open Access
mupvement {b] identiy et steps and actons L.

Carpeta Watch Folder

Mendeley nos permite configurar la opcién de que vigile una o varias carpetas, de forma que cuando

detecte un archivo pdf en esa carpeta lo importe automaticamente. Esta opcién podemos activarla en

[File>Watch Folder] y eligiendo las carpetas a vigilar.
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— - (2] = ]
REDEElcy Peckiob « () e - g S
Flle Ed|t V|ew TooIs Help ‘General Document Details File Organizer Watched Folders BibTex Zotero Connection
Add FHES Ctr|+0 Tick the folders you want Mendeley to watch. Any new PDFs in these folders will be imported into Mendeley automatically.
: Ctrl+Shift+O hlang i
> [ L temp
Watch Folder... 4 [@ | Users
Add Entry Manually... > [0 Inviado
» [0} PC-TGRI-2_BcaCPR
Import... 4 > [E] b public
4 @ | TGRI2
Export... Ctrl+E > [} .cAS §
» [0 1l Contacts
Send by E-mail... » E1 0l Desktop
Merge Documents > [7] ) Doceri
> [ ). Documents L
Delete Documents || Downloads 3
b |. Favorites
Remove from Folder > B U Links
Rename Document Files... > O & Music
> [7] [} Pictures B
3 ¥ > [ |l Saved Games
Synchronize Library F5 » ) @ Sewchonr
¥ HE > [O L videos
Sign Out (biblioteca.puertoreal@uca.es) B [l Windows ]
Quit Ctrl+Q = closne o
[ ok [ cancel ][ apply

Importar directamente desde Bases de Datos con Web Importer
Esta es la segunda forma mas comun de importacion, consiste en utilizar una herramienta llamada
“Web Importer” para capturar informaciéon de las bases de datos al hacer busquedas e incluir las

referencias seleccionadas en nuestra cuenta de Mendeley.

Para instalar esta herramienta debemos ir a [Tools>Install Web Importer]

Mendeley Deskiop

File Edit View [Tools] Help

Invite Colleagues...

Install Web Importer

. e P lugin

[d|™ L
Add Files

Mendeley

2 Literature Sed Install LibreOffice Plugin |

] Mendeley sug Check for Duplicates
53
My Library Options
=1 All Documents I . eFid s 13

Al pulsar se nos abrira una pagina web que explica como instalar esta herramienta, si se utiliza los
navegadores Chrome o Firefox, podemos optar por instalar la extensiéon de Mendeley Importer,
pulsando en los enlaces que nos proporcionan.

Si utilizamos Safari o Explorer, como podéis ver consiste en arrastrar un botén con la leyenda “Save to
Mendeley” a la barra de favoritos. Por supuesto esta barra debe estar visible, no se podra soltar en ella

si esta oculta.
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Como veremos también en dicha web, nos informan sobre cémo utilizar esta herramienta, que

funciona con la mayoria de las bases de datos internacionales mas conocidas.

NOTA: Web Importer funciona con nuestro bUsCAdor de forma que esta opcién es la mas comoda
para importar desde nuestro catilogo, asi como con multiples bases de datos, entre ellas Google

Académico.

M Feed  Library  Suggest Stats  Groups  Data Q, Search FAN BcaCPR “ ~

Help Guides Web importer Contact support Feedback & support

Save references to Mendeley from the web easily!

With the Mendeley Web Importer, you can easily save references and PDF files into your personal library.

| €

Using Chrome?

Install Mendeley Web Importer browser extension.

Using Firefox?

Download Mendeley Web Importer browser extension.

2c

Using Safari or Internet Explorer?

Install the Mendeley Web Importer bookmarklet.

1. Make sure your 'Bookmarks' or 'Favourites' bar is visible.
You may need to switch this on from the "View' menu in your
browser.

2. Drag this button to your 'Bookmarks' or 'Favourites’ bar to
add the bookmarklet to your browser.

Using the web importer

be viewing an adi references in the browser. This can mean that you're looking at an actual PDF file, an article entry in an online catalog, or
even a list of search results. The Mendeley Web Importer will scan the page for metadata, and provide you with a list of the results it finds.

To begin the import process, click on the red Mendeley button next to the address barin Chrome, or click the "Save to Mendeley' bookmarklet in your Bookmarks/Favorites if
you're using another browser. Depending on the number of results the Importer finds, you'll be provided with a list of different items, or specific details of a single item. You can
then review the details, and even make manual corrections within the Importer itself, before choosing to add the references to your personal Mendeley library.
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Una vez instalada la herramienta, para utilizarla sélo tenemos que ir a una de las bases de datos y hacer
una busqueda, en la web de resultados, podemos pulsar en el [botén de Mendeley] que la extension nos
ha instalado o en [Save to Mendeley] segin el navegador que utilicemos y veremos una ventana en la
zona derecha del navegador en la que podemos seleccionar las referencias que queremos incorporar a

nuestra cuenta.

Archive Editar Ver Historial Marcadores Herramientas Ayuda — O X

¢ Q Buscar wBa & @

GO gle open access -

m open access - Google Aca... X =

€ ﬁ ©) @ | hitps://scholar.google.es/scholar?q=open +access&btnG=&hl=es&as_sdt=0%2C5

@ Mas visitados (B Saveto Mendeley

LaWeb Imagenes Mas...

Académico Aproximad 000 resultados (0,05 s
Download PDFs if available
-
Articulos Sugerencia: Buscar selo resultados en espafiol. Puedes especificar el idioma de busqueda en Configuracion de 1 Sepices marketing: Integrating customer
. . . focus across the firm

Mi biblioteca [uero] Services marketing: Integrating customer focus across the firm

A Wilson, VA Zeithaml, MJ Bitner, DD Gremler - 2012 - strathprints_strath_ac_uk Wison A, Zeithaml VV, Bitner M, et. al

... Tweets by @StrathclydeOA. Contact us. Open Access enquiries: openaccess(@

. . Details >

Cualquier momenta strath.ac.uk Repository enquiries: strathprints @strath.ac.uk. ...

Citado por 10166  Articulos relacionados Las 6 versiones Citar Guardar Mas
Desde 2016 2 —— q on)
Desde 2015 . § . . omparing the impact of open access

Companng the impact of open access (OA) vs. non-OA articles in the same vs. non-OA artieles in the same jounals
Desde 2012 journals
Intervalo especifico... S Hamad, T Brody - D-lib Magazine, 2004 - eprints.ecs.soton.ac.uk Hamad 5, Brody T

The way to test the impact advantage of Open Access (OA) is not to compare the citation DHib Magazine, 2004

impact factors of OA and non-OA journals but to compare the citation counts of individual OA Details >
Ordenar por relevancia and non-OA articles appearing in the same (non-OA) journals. Such ongoing comparisons ...
Ordenar por fecha Citado por 792 Articulos relacionados Las 12 versiones Citar Guardar Mas

. ) . : JASPAR: an open-access database for
B la Web JASPAR: an open-access database for eukaryotic transcription factor binding eukaryotic transcription factor binding
uscar en la vve prOfI|eS p[oﬁ‘es
Buscar sdlo paginas A Sandelin, W Alkema, P Engstrém... - Nucleic acids ..., 2004 - Oxford Univ Press ) ) )
en espafial Abstract The analysis of regulatory regions in genome sequences is strongly based on the Sandein A, Akema W, Engstrom P

detection of potential transcription factor binding sites. The preferred madels for Nucleic acids, 2004

representation of transcription factor binding specificity have been termed position- ...
+1 incluir patentes c P . e ; 95p Y P 8 . Details >

itade por 1221 Articulos relacionades Las 15 versiones  Web of Science: 629 Citar  Guardar

1 incluir citas .

Do open-access articles have a areater research impact? IFUF @uiurg

En algunas bases de datos, como Google Académico o ScienceDirect, incluso nos permite arrastrar a
nuestra cuenta directamente el pdf de la referencia que se descargara directamente en nuestro

ordenador al sincronizar la version instalable con la online pulsando en [Sync].

-
Mendeley Desktop
File Edit View Tools Help

I_;' - > == (o)) -
Add Files Folders Related  Share

Mendeley <] AllDocuments | Edit Settings

#— Literature Search

=
Y . -
L Mendeley Suggest w E Authors Title
B de Granda-Orive, ... El maovimie

My Library para re-e'

= L -
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NOTA: En Dialnet, Web importer no funciona con los listados de resultados de las busquedas pero si
con los registros completos de cada documento, es decir, cuando vemos los datos completos del

documento, como en este ejemplo.

(%]
E Dlalﬂet Buscar Revistas | Tesis Congresos | Registrarse lialound @

Las guerras del agua
Al aide, Luis
Ee i

Las guerras del agua

Autores: Luis Alcaids Add to:
Localizacién: Economia exterior: estudios de 1a revista Politica Exterior sobre |a internacionalizacion de la economia espafiola, 1SS! All Documents v
1137-4772 N° 41,2007 (Ejemplar dedicado a: Agua) , pags. 65-76

Idioma: espafiol Tags:

Resumen

Alolargo de la Historia, |a cooperacion y los enfrentamientos se han sucedido en |a resolucion de los conflictos generados en tor Notes:
agua. No obstante, |a idea de agua como bien escaso es raciente. La coordinacion y los compromisos sobre |os recursos se
convierten en imperativos.

Para importar desde Dialnet mas de una referencia a la vez debemos hacerlo con la siguiente opcion.
Importar indirectamente desde bases de datos en formato RIS

Si utilizamos una base de datos que no esté soportada por Web Importer la alternativa es exportar
desde la base de datos en un formato compatible con Mendeley, por ejemplo en formato RIS, este
formato de exportacion lo ofrecen casi todas las bases de datos. Pero cada base de datos ofrece formas

de importacién con diferentes procedimientos.

Dialnet:
Dialnet por ejemplo ofrece esta posibilidad, al ser la Biblioteca de la Universidad de Cadiz, parte de la

Fundacién Dialnet.

Para ello debemos:
- Estar identificados con nuestra cuenta de usuatrio.
- Marcar las referencias que necesitemos.

- Pulsar en [Seleccion] y en la siguiente pantalla en [RIS]
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B Dlalnetm Buscar | Revistas Tesis Congresos = Autores Ayuda | | Espafiol ¥

Universidad
de Cadiz

Buscar documentos % UCA
= | =

Jesus Fernandez-Garcia

I Universidad Cadiz
Y Filtros 28.019 documentos encontrados
Tipo de documento n Pagina 1 de 1.401 nm [20 v Orden:| Relevancia v B perfi
. B Suscripciones
Articule de revista Syl ) .
Articulo de libro L A . B Mis Bisquedas
H.M.Van den Brink; Isabel-Clara Lorda Vidal (trad.) LR .
Libro X o is Referencias
Alianza Editorial, 2003. ISBN 978-84-206-4551-3
Tesis B seleccion
jiaguat! B sair
Textos completos Catalina Lopez Martinez, Valentin Gavidia Catalan, Juan Rueda Sevilla -
Mo (18 Ministerio de Educacion Cultura y Deporte, Centro de Investigacion y Documentacion
Si (9 Educativa, 2006. ISBN 84-369-4142-X B} Adadir a referencias
Resumen 5]
Materias
Tecnologias ( (Por) una diplomacia del agua B Guardar bisqueda
Geotiencias. Medio (5. Loic Fauchon
ambiente Economia exterior: estudios de |a revista Politica Exterior sobre la internacionalizacion de
Agricultura y alimentacion (3 la economia espafiola, ISSN 1137-4772, N°. 41, 2007 (Ejemplar dedicado a: Agua), pags.
Humanidades (2 25-30
Ciencias juridicas (2 Resumen | Peticién Articulo 0O
Ciencias basicas y (2.138)
experimentales Las guerras del agua
Ciencias biologicas (1.6 Luis Alcaide

B Dlalnetm Buscar = Revistas | Tesis = Congresos Autores Ayuda | | Espafiol ¥

Universidad
de Cadiz

3 documentos seleccionados @ UCA
B w1 DL

Jesus Fernandez-Garcia

¥ Sobre elagua Universidad Cadiz
H.M.an den Brink; Isabel-Clara Lorda Vidal (trad.) B Perfil
Alianza Editorial, 2003. ISBN 978-84-206-4551-3 g o
B Suscripciones
7 nagual! B Mis Bisquedas
Catalina Lopez Martinez, Valentin Gavidia Catalan, Juan Rueda Sevilla B} Mis Referencias
Ministerio de Educacion Cultura y Deporte, Centro de Investigacion y Documentacion Educativa, 2006. ISBN 84-369- B) Sseleccion
4142-X
Resumen g B salir

#| (Por) una diplomacia del agua B Anadi .
Loic Fauchon Anadir a referencias

Economia exterior: estudios de la revista Politica Exterior sobre |a internacionalizacion de la economia espafiola,

ISSN 1137-4772, N°. 41, 2007 (Ejemplar dedicado a: Agua), pags. 25-30 .
Enviar/Exportar
Resumen | Peticién Articulo 0O

n Correo
. RefWork:
ma Pagina 1 de 1 am Deseleccionar todos B remworks
B ris
n Texto
B BibTex
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Proquest:
Todas las bases de datos alojadas en Proquest permiten la exportacion simplemente marcando las

referencias y pulsando en [Exportar/Guardar>RIS]

PI'(J(IJES[ |open access &

[ Texto completo ] Evaluade per expertos @ Maodificar bisqueda | Consejos

Busquedas relacionadas Ocultar Con tecnologia de ProQuest® Smart Search
Electronic publishing = Electronic publishing AND Scholarly publishing = Electronic publishing AND Publishing
Electronic publishing AND Research ® Electronic publishing AND Internet = Electronic publishing AND Libraries = Open

2746064 Resultados * | 104713 libros electronicos de ebrary

Buscar en los resultados | Buscar figuras v tablas relacienadas EA Crear alerta Crear RSS Guardar blsqueda

5 entradas seleccionadas [Borrar] EF ] Guardar en Area personal - Enviar % Imprimir |§| Cita [g Exportar/Guardar

EasyBib

|| Seleccionar 1-20  Vista breve | Vista detallada

EndMote, Citavi o Reference Manager
w1 ﬁ ASISA&T Scholarly Communication Survey: Open Access Authors [Bvista HTML
e Johnson, Margeaux; Roderer, Nancy K. Bulletin of the American Society for PDF

Information Science and Technology (Online) 35.1 (Oct/Nov 2008): 8-11. RefWorks
... Open access to information is an important RIS
...high level of awareness of open access (0A). Almost all (95.7% of particip RTF (funciona con Microsoft Word)

...greater publication trends among open access authors? OA authors

Solo text
Cita/resumen ] Texto completo - PDF (36 kB) olo texto

¥LS (funciona con Microsoft Excel)

2 ﬁlﬁ In the News: Open Access Journals Evista Texto completo

Drug Discovery & Development (Jan 13, 2015). Articulos evaluados por expertos

... & number of open access journals have made the news recently

.. Open access ho! Meanwhile, Elsevier has continued embracing open access G Tipo de fuente

Una vez tengamos el archivo RIS, sélo debemos ir a [File>Import] en Mendeley y seleccionar el

archivo RIS. También podemos arrastrar el archivo y soltarlo en el programa.
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Introducir referencias manualmente

Si es necesario, podemos incluir referencias de forma manual, pulsando en [File>Add Entry Manually]

eligiendo el tipo documental y completando los diferentes campos del registro.

Documents Edit Settings

s .
B Authors Title oot Publshed | Added Detais |
Hatzipanagos, Stylia... The New Document L2 2 ]| s
resal ..
Ri. Saral.; Hole... O o br 16
BLpEE Il = GEIE Type: [Journal Article V] — aor
Dimou, Anastasia; ..  Visu, No Title abr 16
Data L
Authors: Athors L
Prost, Héléne; Sché... Degi 3 abr 16
Insti Journal:
Etchichury, Horadio ... Globy Year: abr 16
scig
Volume: m
Matutinovic, Stela Fil... Opel abr 16
Issue:
Karlsson, Miklas The Pages: abr 16 L
ava
Abstract: r
Forgues, Bernard; Li... Aca abr 16 L N (
B de Granda-Orive, Jo... El mi . abr 16
Lt parg Tags: bl
B Gardia-Algar, Oscar; ... Publ = abr 16
=l ple
@ LdpezTorres Hidalg... Habi HeEs e abr 16
= los
\ J

NOTA: Si conoce un nimero de control del documento que tiene que incorporar, como el DOI, el
ArXiv ID o PubMed ID, podemos incluir el nimero en la ficha y pulsar en la lupa y el programa

recuperara el resto de los datos del documento.

-
MNew Document l._i] 2

Author Keywords:

Date Accessed:

Catalog IDs
ArXiv ID:

DOl

ISSM:

PMID:

Files:

Other Settings

DUnpuinshed work - exclude from Mendeley
Web catalog

[ Reset ] [ Save ][ Cancel ]
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Mendeley cuenta con mas de tres millones de usuarios, cada uno de ellos introduce en sus cuentas

multiples referencias por lo que en su conjunto constituyen un enorme catalogo con millones de

registros en el que podemos buscar utilizando el programa instalable o desde la plataforma web.

Literature Search

Desde el programa de escritorio s6lo debemos pulsar en la opcién [Literature Search] y utilizar el

buscador que nos aparece. Para seleccionar referencias sélo hay que pulsar en el punto a la izquierda de

cada titulo o arrastrar la referencia seleccionada a una de las carpetas de nuestra

Documents]

cuenta o a [All

m Mendeley Desktop

1l [ B = | @ = (5

Add Files Folders Related  Share Sync

Mepdete i +— Literature Sea
#— Literature Search

L Mendeley Suggest

My Library
2l Al Documents
Y Recently Added
1. Favorites
_Q_ My Publications
|| Unsorted
4 || Carpeta Prueba
L Subcarpeta
|4 Open Access
Create Folder...

Groups
= Grupo Pruebas Privado
L& Grupo Prueba Publico
=/ Emotion Regulation
Create Group...

Trash

£ Al nelsted Dnriments

m

Al

Zhang, Sha Li
Antelman, Kristin
Bailey, Charles W.
Beall, Jeffrey
Benson, Philippa J.
Rifirk Bn Chricter

Filter by Authers v

Q' Open access

E  Search Results

When is open access not open access?
Catriona J. MacCallum - 2007 - PLoS Biology

Open Access and Libraries
Charles W. Bailey - 2007 - Collection Management

o The open access advantage.
Gunther Eysenbach - 2006 - Journal of medical Internet research [electronic resource].

The inevitability of open access
DW Lewis - 2012 - College & Research Libraries

o Open Access Overview
eter Suber - 2009 - Exploring Open Access: A Practice Journal

bating open access
[terop - 2004 - Scientist

rating Open Access into Libraries
Cryer; M Collins - 2011 - Serials Review

Why full open access matters
Michael W. Carroll - 2011 - PLoS Biclogy

Equity for open-access Journal Publishing
Stuart M. Shieber - 2009 - PLoS Biology

Open Access Publishing: What Authors Want
Rajiv Mariani; L Fernandez - 2012 - College & Research Libraries

Authors and open access publishing
Alma Swan; S Brown - 2004 - Learned Publishing

Open Access Must Enable Open Use
Cameron Neylon - 2012 - Nature

What is Open Access?{0Open Access)
Kurata Keiko - 2010 - The journal of Information Sdence and Technology Assodia...

Biodiversity conservation demands open access
— nin n -

ER

»

m

hd

Showing 25 search results of 1158800
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Desde la plataforma web, debemos pulsar en [Search] y buscar marcando la opcién [Papers]. Para

incorporar los documentos a nuestra cuenta sélo debemos pulsar en [Save reference]

M Feed Library Suggest Stats Groups BcaCPR ~ v

Peop|e Groups  Support
O, Open Access

Papers

open access m

eq: scienfific impact measures Advanced search

Results 1 - 20 0f 1,461,799 Prev.4 1 2 3 ..73000 » Next Refine search

|| Open Access articles only 8
When is open not open ? 3
Catriona J. MacCallum in PLoS Biology (2007)

As open access grows in prominence, so too has confusicn about what open access means;

hcanfusion arises from a genuine misunderstanding of open...
[} Get full text at journal - Related research 277 readers

Open Access and Libraries

Charles W Bailey in Collection Management {2007)
SUMMARY This chapter examines the majer open access movement statements, analyzes the
open access concept based on these statements, examines the two major open..

Si pulsamos sobre el titulo, podremos ver toda la informaciéon del documento, incluyendo otros

relacionados, el numero de lectores en Mendeley, etc.

M Feed Library Suggest Stats Groups Q, Search BcaCPR ~ %

When is open access not open access?

by Catriona J. MacCallum

Eiological Sciences » Miscellaneous Papers 8 . Save reference to library Share B

‘ Overview

PLoS Biology (2007)

Readership Statistics

Related research Volume: 5, Issue: 10, Pages: 2095-2097

0 277 Readers on Mendeley
ISSN: 15448173

ISBN: 1545-T885 (Electronic)ir1544-9173 (Linking) by Discipline
DOI: 10.1371/journal pbio. 0050285 17% Biological Sciences
PubMed: 17941723 15% Computer and Information Science

13% Education

@ Get full text at journal by Academic Status
21% Ph.D. Student
18% Librarian

Abstract 13% Student (Master)

As Open access grows in prominence, so too has confusion about what open by._Cou_ntry
access means; such confusion arises from a genuine misunderstanding of open 4%? United _States

: ) 4% Malaysia
access by funders, authors, editors, and publishers alike

4% United Kingdom
Related Groups Tags

When Is Open Access Not Open Access? abierto acceso access

autorzy
Catriona J MacCallum in PLoS Biol (2007) definition Elektronisches Publizieren
|j‘ Save reference - @ Get full text at journal Breaders fundatorzy kaoszty instytucji Kritik
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Importar desde las herramientas “Related” y “Mendeley Suggest”

El hecho de que Mendeley se haya convertido en un enorme catalogo sirve a la plataforma para

proporcionar servicios de “descubrimiento” de nuevos documentos para los investigadores.

La herramienta Related, permite ver documentos relacionados con los que tenemos en nuestra
cuenta o con una seleccion de ellos. Sélo debemos pulsar en el botén [Related] y el sistema nos muestra
documentos relacionados que podemos incorporar a nuestra cuenta pulsando en el punto a la izquierda
de cada titulo o arrastrar la referencia seleccionada a una de las carpetas de nuestra cuenta o a “All

Documents”

E Mendeley Desktop

- — —
Add Files Folders Related ~&fare  Sync

Mendeley “|' 11 Related Documents

- Literature Search

I Mendsley Suggest & results based on all documents in 'All Documents'

B SearchResult

vy Library earch Results

= and itutic itories in Fire Lif

=/ All Documents Tan Henderson - 2013 - Fire Technology

D

5 Recently Added Access path to institutional repositories.

4 Favorites Satsuki Kamiya; Y Nonaka; 5 Sugita - 2008 - Journal of Information Science Technology AssadationJoho...

U My Publications Connecting Closed World Research Information Systems Through the Linked Open Data Web

Unsorted Thorsten Hoellrigl - 2012 - International Journal of Software Engineering and Knowled...

Learned society business models and open access: Overview of a recent JI5C-funded study

4 C ta Prueb:
U Carpeta Prueba Mary Waltham - 2006 - Learned Publishing

m

| Subcarpeta

Open d institutional repositories in G progress so far

[ open Access Blisavet Chantavaridou - 2008 - OCLC Systems & Services

Create Folder... sclippy : Connecting Personal Information and Linked Open Data
Tudor Groza; L Dragan; § Handschuh; ... - 2008 - The Semantic Web-ISWC 2009
Groups .

What is open access?

[ Grupo Pruebas Privado Charles W. Bailey, Jr - 2006 - Open Access: Key Strategic, Technical, and Econemic Aspects

[1& Grupo Prueba Publico O —

4], Emotion Regulation Steffen Bernius; M Hanauske - 2007 - Wirtschaftsinformatik

Create Group...

Trash

L all Neleted DA ments

Filter by Authors

M | |
Bailey, Jr, Charles W.

Bernius, Steffen b |
Chantavaridou, Elisavet
Decker, Stfan

Dragan, Laura

Gr Tudnr

] 1] Related documents.

También podemos marcar uno o varios documentos y pulsar botéon derecho del ratén y [Related

Documents]

En cuanto a Mendeley Suggest, es una herramienta de sugerencia de documentos a partir de tu perfil
de usuario y los documentos de tu cuenta, se puede utilizar simplemente pulsando en [Mendeley
Suggest| los documentos sugeridos pueden aceptarse y se incluiran en nuestra cuenta o borrar del

listado.
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Mendeley Desktop

File Edit View Tools Help
4 ~| | E& = 2
Add Files Folders Share
Mendeley

“ | 1] Mendeley Suggest
- Literature Search

] Mendeley Suggest

TOP PAPERS FOR BCACPR

My Library
=] All Documents
(£ Recently Added
. Favorites
B My Publications
[ Unsorted
4[]} Carpeta Prueba
(I subcarpeta
[ Open Access
Create Folder...

Groups
| Grupo Pruebas Privado
LA Grupo Prueba Publico
) Emotion Regulation
Create Group...

Trash

= Al Delated Dnruments

m

Filter by Authors

All

Analisis tipoldgico y tecnoldgico de los conjuntos
ceramicos de la Motilla del Azuer (Daimiel, Ciudad Real)

Sergio Fernandez Martin in Cuadernos de Prehistoria y Argueologia de la
Universidad de Granada (2008)

1311043

3 readers

Salud y Enfermedad en Motilla del Azuer ; una
poblacién de la Edad del Bronce de La Mancha

E. Jiménez-Brobeil Sa, AL- Oumaoui I, Néjers, T. Molina in Revista
Espariola antropologia fisica (2008)
8 readers

Key objectives for water reuse concepts
E. Huertas, M. Salgot, J. Hollender, S. Weber, W. Dott, S. Khan, et al. in
Desalination (2008)

Scientists working closely on issues of water reuse are far from having
solved all concerns related to the practice. From the very beginning of a
waler reuss project, scenarios must be prapared from the 'zero scenario’ (no
reuse) through to more.

54 readers

image (253)

2 readers

| Accept | Remove

| Accept | Remove

| Accept | Remove

| Accept | remove

-

Importar desde otros Gestores de Referencia

Si previamente utilizamos otro gestor de referencias, podemos trasladar nuestras referencias a Mendeley

utilizando alguno de los formatos de intercambio de informacién bibliografica que Mendeley reconoce,

como el formato RIS o el formato BibTeX, que podemos importar con la opcién [File>Import].

m Mendeley Desktop

File Edit View Tools Help

Add Files... Ctrl+O

Add Folder... Ctrl+Shift+0

Watch Folder...

Add Entry Manually... L-rt Settings

Import... > BibTeX (*bib) |
Export... Cirl+E EndNote XML - EndNote v8, X1 to X3 (*xml)  pe
Merge Documents RIS - Research Information Systems (¥.ris)

E Bl Brmmers Zotero Library (zotero.sglite) n
Remove from Folder M.; Characteristic of the Nanoparticles Formed on the
AT =1 u; Shchu...  Carbon Steel Surfaceh Solutions in the Opekhkh...

&3 Synchronize Library F5
Sign Out (biblioteca.puertoreal@uca.es)

Quit Ctrl+Q
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Importar desde Refworks

En el caso de RefWorks, podemos exportar las referencias bibliograficas de nuestra biblioteca de
RefWorks en un formato compatible, como el formato [Bibliographic Software| e importarla en
Mendeley arrastrando y soltando el archivo en el programa, como al importar articulos en pdf, de esta

forma Mendeley reconocera las referencias y las importara.

En el canal de la Biblioteca en YouTube puede ver un videotutorial en el que se explica paso a paso el

proceso, incluyendo la forma de mantener la ordenacion en carpetas y el traslado de los archivos pdf.

[Videotutorial Migrar de RefWorks a Mendeley: https://www.youtube.com/watch?v=V7jCIL.rMZqQY]

Importar desde Endnote
Desde EndNote podemos exportar en formato XML para migrar las referencias a Mendeley e

incorporar ese archivo XML a través de la opcion [File>Import].

Importar desde Zotero
Mendeley permite sincronizar la Biblioteca de Zotero con la de Mendeley, sélo debemos ir a

[Tools>Options], en la pestafa [Zotero] podemos activar la sincronizacion.

mc_cmons
General Document Details File Organizer | Watched Folders BibiTex Zotero Connection

Zotero integration
Lecate your Zoters sqlite dombese o enable continuous Zoters import:
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La barra lateral derecha permite editar los datos de las referencias en caso de que tras la importacion

existan datos erréneos o para completar los inexistentes. De la misma forma, si tras importar la

referencia queremos adjuntar el documento a la misma, podemos hacerlo en la opcién [Add File]

NOTA: Cuando se importa una referencia y el programa detecta que estd incompleta crea una carpeta

con el nombre [Needs Review] donde las unifica hasta que las revisemos.

Mendeley Desktop E@g
File Edit View Tools Help
PR IR R == Q-s=
Add Files Folders Related  Share Sync Search
Mendeley = All Documents Edit Settings
l ' Literature Search -
I' Mendeley Suggest * ® B Authors Title Vear PublishedIn  Added Detzils | Notes | Contents | Envichmenis
. B2 de Granda-Orive, Jos El movimiento Open Access: foportunidad parare- 2015 Archivos de abr 186 Tags:
My Library = evaluar el proceso de revisidn por pares (peer re Bronconeumolog
E‘; All Documents . Dimou, Anastasia; De ... Visualizing the Information of a Linked Open Data 2014 Procedia abr 15
() Recently Added H Enabled Research Information System Computer Sdi... Author Keywords:
Eavorites . Etchichury, Horado Ja... Gl_obal furcz_as and local currents in Argentina's 2014 Athenea Digital abr 16 Linked Open Data; Linked Open Data
Ja\ Lo sdence policy crossroads: Restricted access or o... wisualizations; Research information system
&, My Publications ° Forgues, Bernard; Liar... Academic publishing: Past and future 2013 Management  abr 16
| Unsortes Tance -
d Date Accessed:
b L curse . B Garda-Algar, Oscar; V... Publicaciones dentificas: Presente y futuro 2013 Archivos de abr 15 20150416
|| Open Access = Bronconeumolog
b Publisher:
Create Falder... ° Hatzipanagos, Styliano... The role of open access and open educational 2015 Electronic abr 15 i
s resources: A distance learning perspective Journal of e-... Elsevier
Groups ° Karlsson, Niklas The crossroads of academic electronic availability: 2014 Current Science abr 16 URL:
[ Grupo Pruebas Privado How well does Google Scholar measure up again... o
(1 hittp: /v scopus. comfinward frecord.url?
|4 Grupo Prueba Publico B Lépez-Torres Hidalgo, ... Habitos de lectura de revistas dentificas en los 2011 Atencion abr 16 i/ " i I ]
= médicos de Atencidn Primaria Primaria A
! 2dicns d i -
Emotion Regulation
= g . Matutinovic, Stela Filipi  Open access in botany 2014 Botanica abr 15
Create Group... Serbica Catalog IDs
° Prost, Héléne; Schiipf... Degrees of Openness: Access Restrictions in 2014 D-libMagazine abr 16 Ariy ID:
Trash Institutional Repositories DOL: 10.1016j.procs. 2014.06.039 >~
; Al Deleted Documents . Rizor, Sara L.; Holley, ... Open Access Goals Revisited: How Green and Gold 2014 Journal of abr 16 ISSN: 18770509
Open Access Are Meeting (or Not) Their Criginal Scholarly Publi f—
Filter by Authors | Fles:
Al = les:
de Granda-Crive, José Ignacdo Add Fiie
De Vocht, Laurens
Dimou, Anastasia Other Settings
Etchichury, Horacio Javier DUnpublishEd work - exdude from Mendeley Web
Forgues, Bernard catalog
Garcia-Alnar Ascar A

| B i

1 of 11 documents selected

NOTA: Podemos editar un campo de varias referencias a la vez simplemente seleccionando las

referencias y cambiando ese campo en la barra lateral derecha.
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Mendeley Desktop
: File Edit View Tools Help
-l &= |le] 2] S
Add Files Folders Related  Share Sync Search
Mendeley “| &l AllDocuments
-~ Literature Search
I Mendeley Suggest * ® E Authors Title Year PublishedIn  Added Details Contents | Enrichments
. B Suber, P. A very brief introduction to open access 2004 Retrieved 5:14pm SiTTETEET T
My Library = October Edits wil affect all selected documents,
|l All Documents . Lozano, M; Real-coded memetic algorithms with crossover hill- 2004 Evolutionary 5:13pm Merge Documents
) Recently Added dlimbing computation
5 4 Garcia, 5; M... A study on the use of non-parametric tests for 2009 Journal of 5:13pm) .
E‘ Favorites L analyzing the evolutionary algorithms' behaviour: . Heuristics Type: [J"“mal Article
My Publicati -
& My Picalns - Harnad, S; ... Comparing the impact of open access (OA) vs. non- 2004 Db Magazine  5:07pn} Title
[ Unsorted DA articles in the same journals Auth .
= uthors: A
4 ||, carpeta Prueba 3 .8 Antelman, K Do open-access artides have a greater research 2004 College & 5:07pny
| subcarpeta impact? research librar... Journal:
|| Open Access . LopezTorre... Habitos de lectura de revistas dentificas en los 2011 Atencon abr 16 Year:
médicos de Atencién Primaria Primaria
Create Folder. . - - Volume:
. E Garcia-Algar... Publicaciones cientificas: Presente y futuro 2013 Archivos de abr 16
Groups H Bronconeumolog Issue:
[E Grupo Pruebas Privado .- de Granda-... El movimiento Open Access: Zoportunidad parare- 2015 Archives de abr 16 Pages:
evaluar el proceso de revisién por pares Bronconeumalog
LA Grupo Prueba Publico Abstract:
A Forgues, Be... Academic publishing: Past and future 2013 Management abr 16
L
4|, Emotion Regulation .} (France)
4l Software Process Improve... Karlsson, Mi... The crossroads of academic electronic availability: 2014 Current Science abr 16 .
* Tags:
Creats Group... How well does Google Scholar measure up agains. 'gs:
- . Matutinovic... Open access in botany 2014 Botanica abr 16
Serbica Author Keywords:
[Fﬂtﬂ by Authors v ] il ° Etchichury, ... Global forces and local currents in Argentina's 2014 Athenea Digital abr 16
Al L science policy crossroads: Restricted access or op
;"ts‘m_ar"' K ° Prost, Hélén_. Degrees of Openness: Access Restrictions in 2014 Db Magazine abr 16 Date Accessed:
rody, Institutional Repositories
de Granda-Orive, José Ignacio
De Vocht, Laurens . Dimou, Anas... Visualizing the Information of a Linked Open Data 2014 Procedia abr 16
Dimou, Anastasia L= Enabled Research Information System Computer Sde...
, -
Etchichury, Horacio Javier |4 T ] +
g 11| 5 of 16 documents selected

Ver las Referencias

Todas las referencias de nuestra cuenta las podemos ver pulsando en [All Documents| con la
informacién en columnas o en vista de cita pulsando en [View>Library as Citations]

NOTA: Podemos seleccionar que campos se muestran de cada tipo documental pulsando en
[Tools>Options] y la pestafia [Document Details], los previamente seleccionados son los que Mendeley

considera basicos.

Options [® = |

General Document Details File Organizer Watched Folders BibTex. Zotero Connection

Document type: [Joumal Article -

Show fields:

& Title

[H] Authors
W Abstract
[ Tags b
[H] Journal

[H] Volume

B Issue

[H Pages

(@] vear

[ URL

[H] Author Keywords

(M Files

[H] Hide from Mendeley Web Index
[ Application Number

Ar¥ivID

[] Chapter

[ Citation Key

O city

[ Code

[[] Country

Date Accessed

[0 Day =

| »

m

ok | [ cancel | [ apely
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Ordenar referencias con las columnas
Podemos ordenar las referencias por cualquiera de las columnas simplemente pulsando en la cabecera

de cada una de ellas.

Crear y organizar carpetas
Para crear una carpeta s6lo hay que pulsar en [Create Folder] y escribir el nombre que queremos asignar

a la carpeta.

Mendeley Desktop

|4 |™ ) = ()] fad s

Add Files Folders Related  Share Sync

Mendeley “ | Z AlDocuments |EditSettings

o+~ Literature Search —
N ° ; : .
I_. Mendeley Suggest * E  Authors Title Year Published. Added
® Hatzipanagos, ... The role of open access and open 2015 Electronic  abr 16
My Library = educational resources: A distanc... Journal o...
::" All Documents ° Rizor, SaraL.; ... Open Access Goals Revisited: How 2014 Journal of  abr 16
DR v Added Green and Gold Open Access Are ... Scholarly ...
5 Recently Adde
Eavorite . Dimou, Anasta... Visualizing the Information of a 2014 Procedia abr 16
E"\ avories Linked Open Data Enabled Resea... Compute...
My Publicati e B
s My FLblications ° Prost, Héléne; ... Degrees of Openness: Access 2014 D4dib abr 16
| Unsorted Restrictions in Institutional Reposi... Magazine
4 || Carpeta Prueba ® Etchichury, Hor ... Global forces and local currents in 2014 Athenea  abr 16
I Subcarpeta Argentina's science policy crossro... Digital
|| Open Access . Matutinovic, St... Open access in botany 2014 Botanica abr 16
h Serbica
Create Folder...
Karlsson, Miklas ~ The crossroads of academic 2014 Current abr 16
e electronic availability: How well d... Science
|E| Grupe Pruebas Privado i e Forgues, Bern... :J?Jr;l:mic publishing: Past and 2013 reﬂFar;:g:Ter abr 16
L& Grupo Prueba Publico ) . .
] ] . B Garcia-Algar, O... Publicaciones cientificas: Presente 2013 Archivos de abr 16
5/ Emotion Regulation M = y futuro Bronconeun
Create Group... @ LopezTorres Hi... Habitos de lectura de revistas 2011 Atencion  abr 16
=l dentificas en los médicos de Aten... Primaria
Trash b . ' de Granda-Cri... El movimiento Open Access: 2015 Archivos de abr 16
Bl Al neeted 0 e |7 = ‘oportunidad para re-evaluar el p... Bronconeun
2 ela AcLmen
" i Eysenbach, Gu... The open access advantage. 2006 Journal of  5:16pm
Filter by Authors - ]lfl L] medical Tn...
Al E
de Granda-Orive, José Ignadio ® Peter Suber Open Access Overview 2009 g;i_lﬁr:cgc 5:16pm

De Vocht, Laurens
Dimou, Anastasia
Etchichury, Horacdio Javier
Eysenbach, Gunther

Enraues Rernard

| ] |

Para crear una subcarpeta, debemos seleccionar la carpeta en la que queremos crear la subcarpeta y
pulsar [Botén derecho del raton>New Folder] y asignar un nombre a la subcarpeta. También podemos

arrastrar y soltar las carpetas para insertarlas unas dentro de otras y asi organizarlas.
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Podemos renombrar o borrar una carpeta seleccionandola y pulsando en [Botén derecho>Rename

Folder / Remove Foldet]

=] Al Documents . Etchichury, ... Global forces anc
'Y Recently Added policy crossroads
7 Favarites

_D_ My Publications

| Unsorted L

. B Ldpez-Torre... Habitos de lectur
médicos de Aten

[

o Garcia-Algar... Publicaciones cie

L =

4 || Carpety
m Related Documents
LFi Open A Rename Folder... F2
Create Remove Folder
Groups Edit Settings
e I New Folder.. Ctrl+Shift+N I
L& Grupo
4 Emotio New Group... Ctrl+Shift+M
% Software Process Improve
Create Group...

Colocar y Quitar referencias en Carpetas, Borrar referencias
Para colocar referencias en una carpeta solo hay que seleccionar las referencias y [Arrastrar y soltar] en

la carpeta donde queremos colocatlas.

Para sacar una referencia de una carpeta, debemos seleccionar la referencia y pulsar [Botén derecho del

raton> Remove from Folder]

Para borrar una referencia, de forma que se envia a la papelera de reciclaje del programa, debemos

pulsar [Botén derecho del ratén> Delete Documents|

NOTAS: las referencias pueden estar en multiples carpetas, al marcar una referencia, se sombrean las
carpetas en las que estd incluida esa referencia. La carpeta [Unsorted] contiene las referencias que no

estan en ninguna carpeta.
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Mendeley Desktop
: File Edit View Tools Help
|j bl ] = @ IL? s
Add Files Folders Related  Share Sync
Mendeley “| 2] AllDocuments | Edit Settings
o+ Literature Search
I Mendeley Suggest * @ [ Authors Title Year Published In
. Forgues, Be... Academic publishing: Past and future 2013 Management
My Library o {France)
= All Documents . Karlsson, Ni... The crossroads of academic electranic availability: 2014 Current Science
DR Hy Added How well does Google Scholar measure up against .
& Recently Adde
Favorites * Matutinovic... Open access in botany 2014 Botanica Serbica
8 My Publicati
— Lo cations * Hatzipanag... The role of open access and open educational 2015 Electronic
o resources: A distance learning perspective Journal of eL...
4 ||| Carpeta Prueba E . @ LlGpezTorre... Habitos de lectura de revistas centificas en los 2011 Atencion
|| Subcarpeta = médicos de Atendén Primaria Primaria
|/ Open Access ° B Garca-Algar... Publicacdiones dentificas: Presente y futuro 2013 Archivos de
b A Bronconeumologi
Create Folder...
- Etchichury, ... Global forces and local currents in Argentina's sdence 2014 Athenea Digital

Sincronizar Archivos

Mendeley nos permite seleccionar que carpetas sincronizan los archivos adjuntos de sus referencias,

para ello sélo debemos pulsar en [Edit Settings] y seleccionar las carpetas que queremos sincronizar.

m Mendeley Desktop
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File £d 1y Qols Heip

LT * = m g o
Add Files Folders Related Share Sync

Mendeley < All Documents Hide Settings '
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My Library
# All Documents

“ Recently Added

| synehronize attached files
This synchrondres POFS (and other attached files) with your Mendeley
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@) For my entire library

 Favorites
3 . For selected folders
2 My Publications
R, My Publications
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i Carpela Prueba
I Biblioteca .
pen AdCess
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I Open Access
Create Folder..

Web Space usage

Groups ﬂ
“ Grupo Pruebas Priva..
&Grupo Prueba Publico
< Emotion Regulation
# Software Process 1.
Create Group...

Trash
= All Deleted Docume...
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a

Biblioteca de la Universidad de Cadiz

Pig. 28 de 59



| Universidad

de Cadiz http:/ /biblioteca.uca.es

W UC

Area de Biblioteca

Favoritos

Las referencias que marcamos con el [Icono de estrella] aparecen directamente en la carpeta [Favorites].

Marca de Leido / No leido

Marcar o desmarcar el [Punto verde| a la izquierda de cada referencia nos permite distinguir entre

referencias leidas y no leidas.

B2 Mendeley Desktop T ———

File Edit View Tocls Help

(17| | Eo = @ = o

Add Files Folders Related  Share Sync

Mendeley
' Literature Search
L Mendeley Suggest

My Library
=1/ All Documents
.+ Recently Added

1 Favarites

Ty

&, My Publications

[ Unsorted
4 ||| Carpeta Doctorado

L[/ Open Access
Create Folder...

Groups
51 Grupo Pruebas Privado
L Grupo Prueba Publico
=/ Emotion Regulation
Create Group...

Busquedas

||y subcarpeta Doctora...

»

m

2] Edit Settings
-

=]l all Documents
w ® [ Authors

de Granda-Orjye, José Igna...

e B
|

@ astasia; De Viocht...

|

L g Etchichury, Horado Javier; P...
* Forgues, Bernard; Liarte, Se...

o @ Garda-Algar, Oscar; vall Co...
. Hatzipanagos, Stylianos; Gr...
Karlsson, Miklas

e B Ldpez-Torres Hidalgo, Jesds
Matutinovic, Stela Filipi

Prost, Héléne; Schipfel, Joa...

Title

El movimiento Open Access: éoportuni
evaluar el proceso de revisién por pan

Visualizing the Information of a Linked
Enabled Research Information System

Global forces and local currents in Arg
policy crossroads: Restricted access o

Academic publishing: Past and future

Publicaciones cientificas: Presente v fi

The role of open access and open edu
resources: A distance learning perspe:

The crossroads of academic electronic
How well does Google Scholar measure

Habitos de lectura de revistas dentific
médicos de Atencién Primaria

Open access in botany

Para localizar rapidamente referencias en nuestra cuenta de Mendeley, el programa cuenta con dos
sistemas, el primero es la caja de busqueda rapida que se encuentra en la zona superior derecha y
etiquetada como [Search], pulsando en la lupa podemos seleccionar un campo concreto en el que

buscat.
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Add Files Folders Related  Share Sync Search
Mendeley = f: All Documents
#- Literature Search
ol Results for "open access™ in "All Documents™ Clear Details | Motes | Contents | Enrichments
Mendeley Suggest
-
My Library * ® [ SearchResults il Type: [Jnumal Article &
Open access in botany
\Z} All Documents Stela Filipi Matutinovic - 2014 - Botanica Serbica The role of ‘open access and
L] Abstract: ..and the internet are described. Open access to information is a key factor for the ... open educational resources: A
+ Recently Added pe
- v Author Keywords: Botany, E-publications, Open access distance Iearning perspective
1. Favorites
- Global forces and local currents in Argentina's science policy crossroads: Restricted access or open knov . -
9. My Publications A Horacio Javier Etchichury; MC Pacheco - 2014 - Athenea Digital Authers: S, Hatzipanagos, 1. Gregson
] E Abstract: .. the article describes how the Open Access movement has entered the debate. The World y 7
L M. View research catalog entry for this paper E
4 ||| Carpeta Doctorado rees of Openness: Access Restrictions in Institutional Repositories —
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2 - Pages: 95-104 I |
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Create Group... o ""? role of open access and open edmt'““‘_’l A di i learning ctive and Open Educational Resources within Distance
Stylianos Hatzipanagos; J Gregson - 2015 - Electronic Journal of e-Learning Education, with a focus on the context of the
Filter by futhars P L] Abstract; .. paper explores the role of Open Access (in licensing, publishing and sharing research University of London International Programmes.
. g — Author Keywords: Digital schelarship, Open access, Open access publishing and licensing, Open and... VWe report on a case study where data were
F“e' by Author Keywords L L . . . . . gathered from librarians and programme
Filter by Authars = . El r[mvlmlerlln Open MDF_-E ioportunidad para el p s de por pares (peer review directors relating to existing practice around
Filter by My Tags L] E__ José Ignacio de Granda-Orive; G Segre... - 2015 - Archivos de Bronconeumologia Open Access; the major constraints in using
Filter by Publications _ _ Open Educational Resources and the main
Etchichury, Forado Javier Academic p“".rSh""F Past and future resource implications, when adopting Open
’ . ?emard Forgues; 5 Liarts - 2013 - MaPagament (FTEQCE) . — || Educational Resources, were also investigated.
Forgues, EE""I‘El’d Abstract: | We then discuss how the "open access” movement responds to these issues and how it Our aim was to (&) raise awareness and
Gardia-Algar, Oscar understanding of what i i ieve i
i B B B g of what is possible to achieve in
Gardia-Rio, Frandsco TII:Ie ‘ of electronic v: How well does Google Scholar measure up against a v higher education by embracing the Open Access
Gregson, Jon . Niklas Karlsson - 2014 - Current Science movement (b) identify next steps and actions t...
Harinananns. Stiliana: - Abstract: ..is now vital, Will the open access movement evolve with Google as the main actor ... - o

1 of 11 documents selected

NOTA: Si no seleccionamos un campo de busqueda especifico, la bisqueda se realiza en todos los

campos del registro incluyendo el campo Notes (pero no en las notas tipo Post it) y también en los

documentos a texto completo, si la palabra la encuentra en el documento, al abrirlo nos sefiala

subrayado el texto buscado y sobre el documento las veces que ha sido encontrado.
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Select Highlight Mote Rotate Zoom Fulscreen  Share Sync Search /
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Showing match 1 of 9

COMENTARIO EDITORIAL

| petais | notes | contents | Enchmens |

Habitos de lectura de revistas cientificas en los médicos

de Atencién Primaria

Scientific journal reading by Primary Care physicians

Jesus Lopez-Torres Hidalgo

Unidad de Investigacion, Gerencia de Atencion Primaria de Albacete, Albacete, Espana, Editor de Revista Clinica de Medicing [E

de Familia

En medicina el reconocimiento de la necesidad de forma-
cion continuada ya fue resaltado por Hipocrates' y hoy nadie
discute que es necesaria para mantener la competencia pro-
fesional y que es una responsabilidad mayor del médico a lo
largo de toda su vida®.

La formacion implica el manejo de informacion cien-
tifica, cuya calidad y aprovechamienta por parte del
médico constituyen la base de unas decisiones clinicas
correctas. Pero los medicos son profesionales adultos, y
como tales prefieren un enfoque autodirigido y deben
ser capaces de identificar sus propias necesidades de for-
macién, de formular sus objetivos de aprendizaje y de
identificar por si mismos los recursos necesarios para
alcanzarlos'~. Segin los resultados del interesante estu-
dio realizado por Gonzalez de Dios et al.“ sobre habitos
de lectura de revistas cientificas en meédicos de aten-
cion primaria espafioles de las 17 comunidades auténomas,
las revistas mas leidas son las propias de la especiali-
dad {Medicina de Familia o Pediatrial, siendo la revista

ATENCI M Pawania la preferida por el 20% de los médicos de fami-

lia, en segundo lugar tras una revista de informacion médica
general.

Al respecto, las revistas médicas aportan un recurso de
facil acceso para alcanzar los objetivos de la formacian
autodirigida, pero su valor depende de manera crucial de
la calidad de sus contenidos’. El exceso de informacidn
(mas de 20.000 publicaciones biomedicas en todo el mundo
con una produccion anual de casi 2 millones de articulos),
redundante con frecuencia, puede llegar a desorientar al
lector y tal vez repercutir negativamente en la actuacion
profesional.

Aungue en los resultados del estudio de Gonzalez de Dios
et al.* todavia predomina el formato impreso, el 57T% de los
meédicos de atencion primaria también utilizan el electra-
nico, especialmente los mas jévenes, No cabe duda de que
Internet permite un grade de accesibilidad, difusion, visibili-
dad e impacto de la informacian cientifica como antes jamas
se_hahia nroducida® Hov en dia_el médicn nuede arceder

—|| Atencion Primaria

m

-

Type: [Jmmal Article - I

Habitos de lectura de revistas
cientificas en los médicos de

Authers: 1, | Gpez-Torres Hidalgo

M. ‘iew research catalog entry for this paper

Journal: - Afencion Primaria
Year: 2011 1
Volume: 43
M Issue: 12
Pages: 636637
Abstract:
Tags:

Author Keywords:

Date Accessed:

Filtrar referencias
El segundo sistema de localizacién de referencias es la opcion de filtrar por una serie de parametros
como: autor, palabras clave, etiquetas o nombre de revista, esto se puede hacer en el desplegable

etiquetado como [Filter] en la zona inferior izquierda.
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Filter by My Tags

Filter by Publications
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NOTA: Los filtros nos pueden ayudar a detectar errores en nuestras referencias, como que el mismo
autor tenga dos entradas por nombre o la misma revista dos entradas por titulo. En ese caso, podemos
arrastrar la entrada incorrecta sobre la correcta y el programa nos pregunta si queremos unificar ese

campo en las diferentes referencias.

Universidad
de Cadiz

Filter by Authors -

Lozana, M

Lapez-Torres Hidalgo, Jesls
Mannens, Erik

Matutinovic, Stela Filipi

Malina, D ?
Molina-Cabrera, Daniel

Pacheco, Marcela Carmen
Prost, Héléne

Rizar, Sara L.

schapfel, Joachim
segrelles-Calvo, Gonzalo
Suber, P,

Vall Combelles, Orial

Van Campe, Leen

Yan de Walle, Rik

m

Comprobar Duplicados

Podemos comprobar si existen duplicados entre nuestras referencias pulsando en [Tools>Check for

Duplicates| de forma que el sistema, si detecta duplicados, nos permite revisarlos y fusionarlos si vemos

que realmente son duplicados.

Area de Biblioteca

L2 ]

’
Confirmation

Rename all instances of "Muolina, D" to "Molina-
Cabrera, Daniel”?

[7] Do not ask again

[ Ok ] [ Cancel

e

Mendeley Desktop

File Edit View ET:mIsl Help

http: / /biblioteca.uca.es

5 Invite Colleagues...

L Mendeley Sug

My Library

=l All Documents

+— Literature Ses

] e L%
Add Files Fol Install Web Importer
Uninstall M5 Word Plugin
Mendeley

Install LibreOffice Plugin

Check for Duplicates

Opticons

AT~ e
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Recently Added y Recently Read:

Estas carpetas del sistema nos permiten ver lo recientemente afiadido y los ultimos documentos que
hemos estado leyendo.
Mendeley
+— Literature Search
_I_, Mendeley Suggest

My Library

=1 All Documents

+ Recently Added
|_H__| Recently Read
i1 Favorites
_':'_ My Publications
Unsorted

L/ Algediras

||/ Biblioteca

|y Puerto Real
Create Folder...

Trabajar con Documentos

Herramientas de Lectura
Cuando abrimos un documento PDF en Mendeley, el programa nos ofrece un lector con una serie de
[Herramientas de lectura] que nos facilitan el trabajo con el documento, herramientas como zoom, por

si la letra es demasiado pequefia o demasiado grande y una opcién de lectura a pantalla completa.

m Mendeley Desktop
File Edit View Go Tools Help

LAl -] & O 4 -0~ Q @ e t 82 2|06

Select Fan Mote Highlight Color Zoom Zoom To Fit Fullscreen Sync Help

Subrayar y Tomar Notas estilo Post-it y en la pestafia “Notas” de la referencia

La aplicacién también permite subrayar texto y tomar notas tipo Post-it, con diferentes colores,
replicando el trabajo que normalmente se realiza a mano cuando se lee en papel. Los botones

[Highlight] y [Note] permiten llevar a cabo ambas acciones.
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E Mendeley Desktop

File Edit View Go_Tools Help

Area de Biblioteca

http: / /biblioteca.uca.es

AI M &IJ 0 Ag - ~ Q Q « 1 B r @ Q- Search. BeaCPR “
Select Pan Note Highlight Color. Zoom Zoom To Fit Fullscreen Sync Help
My Library B Characteristic of the Nano... [

Background

Nowadays, iron—oxygen-containing nanoparticles due to
their high catalytic and magnetic properties are widely
used as precursor species for the creation of various ma-
terials for technical and bio-medical application [1, 2].
The presence of 3d-metal cations such as copper, cobalt,
nickel, and zinc in the crystal lattice of iron oxides and
oxyhydroxides significantly changes their physical—
chemical properties and may be important for enhancing
the quality of the obtained materials as well as for
imparting new properties to the existing materials [3, 4].
Typical methods for obtaining iron-oxygen high-disperse
~ marticles are well kknown and deseribed in numerous re-

5 9 View among the di-

—v

' BcaCPR Universidad de Cadiz justnow p formation of the
on or steel surface

Ejemplo de Nota
he presence of an

anionic part (chlorides, sulfates, nitrates, etc.) in the re-
action area is insignificant.

Recently, we have proposed an alternative method for
the formation of various iron-oxygen mineral nanoparti-
cles, including spinel ferrites, on the surface of the steel
electrode contacting with air and water medium that
was called the rotation-corrosion dispergation (the RCD)
[7]. The kinetic study of the processes of the phase for-
mation on the steel surface contacting with distilled
water showed the appearance of Fe(ll)-Fe(lll) layered
double hydroxides (LDHs) or green rust as the primary
(first nucleus) phase within 1-3 h. The presence of fer-
rous cations in the hydroxide layers makes the green
rust structure unstable to further dissolution or oxida-
tion. While, the presence of 3d-metal inorganic salts in
the dispersion medium contacting with the iron or steel
surface provides the nucleation of mixed Fe-3d-metal
layered double or triple hydroxides, whose physical—

h | properties significantly differ from the proper-

* Correspondence: alena-lavry@yandexru
FD. Ovcharenka Institute of Bio-Colloid Chemistry of NAS of Ukraine,
Wernadsky Ave, 42, 03142 Kyiv, Ukraine

ties of the chemically pure Fe(ll)-Fe(Ill) LDHs. It is
known that the typical mixed LDHs are remarkable for

® 2016 Lavrynenko et al. Open Access This article is distributed under the terms of the Creative Commans Attribution 40

.
@ Spl’lnger Internatienal License (http://creativecommans org/licenses/boy/407), which permits unrestricted use, distribution, and

reproduction in any mediumn, provided you give appropriate credit to the original author(s) and the source, provide a link to
the Creative Commeons license, and indicate if changes were made.

Details Qﬂ_ﬁﬂQ Contents

GENERAL NOTES B I U
PRIVATE ANNOTATIONS
| O ]
I | BcacPr Universidad de cadiz Just now
Ejemplo de Nota
| O~ ]

I 5cscR Universidad de caciz

Ejemplo de Nota

Just now

Page 10f 9

Las notas podemos colocarlas en la zona que queramos del documento, asociadas por tanto al parrafo

que queramos.

Ademas existe una pestafia [Notes] en la barra lateral derecha en la que tenemos un campo de nota que

también podemos utilizar para crear notas referidas al documento en su conjunto.
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Exportar PDF con Notas y subrayados

Las notas y subrayados se sincronizan en todos los dispositivos en los que utilicemos nuestra cuenta de
Mendeley, pero si ademas queremos una copia del PDF con nuestras notas y subrayados, podemos

crearla pulsando en [File>Export PDF with Annotations] (S6lo en vista de documento).

Si queremos sélo un documento con nuestras anotaciones, tras pulsar en [File>Export PDF with
Annotations] solo tenemos que seleccionar la opcién “Notes” y desmarcar la opcion “Article” de esa

forma tendremos un documento PDF sélo con los textos de nuestras notas.

4 Mendele
File| Edit View Go Tools Help

Add Files... Ctrl+0
Add Folder.. Ctrl+Shift+O

Watch Folder..
Add Entry Manually...

Import... »
Export... Ctrl+E

Send by E-mail...

Merge Documents

Close Tab Ctrl+W

Export PDF with Annotations...

Print... Ctrl+P
Rename Document Files...
Synchronize Library F5

Sign Out (biblioteca.puertoreal@uca.es)
Quit Ctrl+Q
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Creacion de una bibliografia

Formatos Bibliograficos: Seleccionar y Organizar

Mendeley ofrece una amplia gama de formatos bibliograficos, en [View>Citation Style] podemos ver
los mas usuales y los que vayamos utilizando, si queremos seleccionar otros, podemos buscarlos
pulsando en [View>Citation Style>More Styles]

File Edit [View] Tools  Help

5 || | @ Library as Table
L&

Add Files Library as Citations

Citation Style 4 American Medical Association
Toolbar Layout » American Psychelogical Assoaation 6th edition
Show Document Details AltsReturn Chicago Manual of Style 16th edition (author-date) fear
Mendeley Suggest Chicago Manual of Style 16th edition (note) 2015
= @  Harvard Reference format 1 (author-date)
=0 All Documents . Dirnou, Anas . 2014
= 150-690 (author-date, Spanish]
Y Recently Added . -
e vorites ° Etchichury, H Modern Language Association 6th edition (note) o014
- o Meore Styles
\_J;: My Publications
. o 2013
[ Unsorted 3 Journal Abbreviations...
I ||/ Carpeta Doctorado o @ Garca-Algar, Oscar; V... Publicacones cientrficas: Presente y futuro 2013
I_. Open Access -
Create Folder... ° Hatzipanaagos, Styliano... The role of open access and open educational 2015
(o] resources: A distance learning perspective

En la ventana que nos aparece podemos buscar, en la pestafia, [Get More Styles| el formato

bibliografico que necesitemos.

Citation Styles . (]

Installed GetMore Styles )| Abbreviations | About

Q journal

Academy of Management Journal

=

AEUE - International Journal of Electronics and Communications
African and Black Diaspora: &n International Journal

African Journal of Emergency Medicine

African Journal of Urology

Agronomy Journal

ALAA Journal

Ain Shams Engineering Journal

Ameriran lournal of Phvsinlnav - Cell Phvsinloav

Download Style: Enter URL
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Seleccion de Idioma:
A veces los estilos bibliograficos incluyen palabras dentro de los listados bibliograficos como
“Retrieved from” o “Accessed” si necesitamos que dichas palabras aparezcan en otro idioma, podemos

seleccionatlo.

Inclusién de URL:
También a veces las referencias incluyen las URL del lugar desde el que se descargaron, pero si no

queremos que aparezcan en la bibliograffa, también podemos configurarlo.

Estas dos variantes podemos controlarlas al seleccionar el estilo bibliografico en [View>Citation

Style>More Styles] en la pestafia [Installed]

Citation Styles (=]

Installed | Get More Styles I Abbreviations I About |

Q Search my citation stvles

American Medical Association

American Political Science Association

m

Use this Style

American Sociological Association
Chicago Manual of Style 16th edition (author-date]
Chicago Manual of Style 16th edition (full note]

Chicago Manual of Style 16th edition (note)

Incude URLs and Date Accessed in Bibliographies: [Gﬂly for Webpages - ]

Citation and Bibliography Language: [Spamm (Spain) - ]
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Editor de Estilos de Citas
Mendeley nos ofrece un gran numero de estilos de citas diferentes, desde los formatos mas conocidos
hasta los de miles de revistas académicas, pero si necesitamos trabajar con un estilo de cita propio o

editar uno de los existentes, podemos hacerlo pulsando [Botén derecho del raton > Edit Style]

Citation Styles

— el

Installed | Get Maore Styles I Abbreviations I About |

American Political Science Association

American Psychological Asg=si=t D |
Update Style |

American Sociological Assg ninsta le |

Chicago Manual of Style 16 @ —

Copy Style Link
Chicago Manual of Style 16th edition full note]

m

Chicago Manual of style 16th edition (note)

Harvard Reference format 1 (author-date)

TEEE [l

Indude URLs and Date Accessed in Bibliographies: |For All Document Types
Citation and Bibliography Language: |Spanish (Spain) -

Style - Edit + Help+ American Psychological Association 6th edition - BcaCPR Universidad de Cadiz
STYLE INFO + - EXAMPLE CITATIONS
i @ Info
- ) Global Formatting Options {Accadia et al, 2012)
INLINE CITATIONS (Mcinnis & Nelson, 2011)
: Layout
& Sort

EXAMPLE BIBLIOGRAPHY
BIELIOGRAPHY

Layoul Accadia, T., Acernese, F_, Alshourbagy, M., Amico, P., Antonucci, F., Acudia, S., ... Zhang
a3 Sort PO3012-P03012. hitp:idei.org/10.1088/1748-0221/7/03/P02012
MACROS Melnnis, M. D., & Nelson, L. P. {2011). Shaping the body pofitic; Art and pelitical formation i

i Macro: container-contributors
4 Macro: secondary-contribulors
I Macro: author
i Macreo: author-shor
I Macro: access
IMacro: title
) Macro: title-plus-exira
IMacro: format
I Macre: publisher

Info

 Macro: event American Psyeholcgical Assoelalion §th ediion - BeaCPR: Universidad de Cadiz
- (5 Macro: issued PP e
Macre: [ssued-son Ll
| Macro: |ssued-year o http-/izsl.mendeley com/styles 20081201 fapa ;
\_ 5 Macra: adition To save a copy of this style with a different ID, use Style — Save Style As
- (5 Macro: locators Summary
- (T Macre: citation-locator Rights This work is licensed under a Creative Commens Attrbution-ShareAlike 3.0 License
IMacra: container Published
2 Macro: container-lithe
B p ISSML
IMacro: legal-cites
1 Macro: original-ciate eISSN
ADVANCED
42 Global Formatting Options ISSNs
Add ISSH |
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NOTA: El editor de estilos puede resultar complejo, Mendeley ofrece una gufa de inicio sobre el tema
en [http://support.mendeley.com/customer/portal/articles/895771-getting-started-with-the-visual-csl-

editor] También en la pestafia [About]| nos explican que sistema utilizan para los estilos bibliograficos.
e, =]

Installed | Get More Styles | Abbreviations ‘ About ‘

Citation Styles

About Citation Styles
Mendeley Desktop uses the Citation Stvle Language (CSL) standard.
CSLis an open standard to define styles. The styles are processed using dteproc-is.

Mendeley regularly fetches new styles from Citation Styles project repository. Any new styles you
create can be submitted to this repository,

You can edit styles, or create new styles using the CSL Editor (right-click on an installed style to
open itin the web-based editor).

All styles are offered under the Creative Commons Attribution-ShareAlike 3.0 license.

Crear un Listado Bibliografico con las Referencias

Podemos crear un listado bibliografico con las referencias que seleccionemos y siguiendo el estilo de
cita que queramos, simplemente seleccionando las referencias y pulsando en [Botén derecho del
raton>Copy As>Formatted Citation] luego vamos al procesador de textos y pegamos el texto, que
aparecera en el orden que hayamos marcado al seleccionar las referencias y con el estilo de cita que esté

seleccionado en el programa.
Mendeley Desktop Egu’q

File Edit View Tools Help

(4|7 | Es - @ = [+] Q- Search |
Add Files Folders Related  Share  Sync Search
Hendeley “| 5 AlDocuments |EditSettings
/- Literature Search —
I Mendeley Suggest * ® @ Authors Title Year Published’ Added || Detals | Notes | Contents [ Enichments
. ] deGrands-Oni.. El movimiento Open Access: 2015 Archivosde abr 16 || 5 documents selected
My Library <oportunidad para re-evaluar el p... Bronconeun Edits wil oFruct ol sclected documents.
=) All Documents Dimou, Anasta... Visualizing - 2014 Dencnd e 16
=¥ . . Merge Documents
B mecenty Added W linked Open|  Update Details .
Etchichury, Hor... Global force: Related Documents hs -
» Favoritzs = Argentina's Type: | =) 7
= My Pubieations o Evserboch,Gu. Theopenad  OPEfile om || Title
[ Unsorted il by
Open File Extemally authars: ALt/
4 || Carpeta Prueba N o Forgues, Bern.. gmdemw:pu Open Containing Folder 16 e
|| Subcarpeta 1 AL :
|/ Open Access . B8 Garcia-Algar, O Publicaciones Rename Dg Ho &
: W y futuro
Create Folder... . rge Documents Abstract:
. atzipanagos, .. Mark As y ps U
Groups “ E
[ Grupo Pruebas Privado Karisson, Nikias Copy As 4 Formatted Citation Ctrl-+Shift+ C
LI Grupo Prueba Publico ) ) Export... Ctrl+E LaTeX Citation Command  Ctrl+K
. @ LopezTorresH . Habitos de X
<l Emotion Regulation | dentifeas e Send by E-mail... BibTeX Entry
Create Group... . Matutinovic, St.\ Open access Select Al Cul-a [16
Trash T . Peter Suber Remove from Felder om || City:
2. ol Neleted Nouments Delete Documents
. = Prost, Héléne; ... Degrees of Opes JEper aor 16
Filter by Authors E hd Restrictions in Insumuw Pu
Al =
e Grands-Orive, Tosé Tonaci Rizor, SaraL.; ... Open Access Goals Revisited: How 2014 Journal of  abr 16
Do b e Jose fgnec . Green and Gold Open Access Are Schalarly
Dimou, Anastasia Type of Work:
Etchichury, Horado Javier
Eysenbach, Gunther 3
Erovies Bemard -l i =

L= | 1] 6 0713 documents selected
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Plugin para Word y LibreOffice

La mejor forma de citar y crear bibliografias con Mendeley es utilizar el plugin para los procesadores de
textos Word y LibreOffice.

Para utilizar este plugin debemos instalarlo pulsando en [Tools>Install MS Word Plugin/Install
LibreOffice Plugin] Estas opciones sélo aparecen si el ordenador tiene instalados estos procesadores de

texto.

mplugin Installed E
Mendeley Desktop
o — The installation was successful

File Edit View | Tools | Help
Gl = Invite Colleagues...
1. Start Microsoft Word
Add Files Fol Install Web Importer
Tnstall MS Word Plugin 2. Click on the References tab
Mendeley Eilit Settings The Mendeley Cite-O-Matic plugin shouid show p n the references
. Install LibreOffice Plugin tab in your Micrasoft Ward toolbar. Use this to choose a ditation
#~ Literature Seg S style, insert or ecit tations and bibliographies.
i ; Titl
W7 Mendeley sug Check for Duplicates 2 =
da-Crive, Jos... Elm OUT  REFERENCES = MAILNGS  REVEW
, Jos...
My Library Options eval o), Sty [lsertacitstion . -
=l All Documents Y Doy, Anastasia; De V.. Visu T Insert Elinsent Biiiography Export |
= L Enal Citation [ Refresh - il
£ Recently Added ichich ) b 5 Mendeley Cite-O-atic
- Favorites L . Etchichury, Horadio Ja.. Gg
N - scier

Configuraciéon de Macros de Word

A veces Microsoft Word puede bloquear la visualizacién del plugin de Mendeley, normalmente esto se
produce cuando tiene inhabilitadas las opciones de Macros, en este caso, debemos proceder a la
activacion de Macros en Word en: [Archivo> Opciones> Centro de Confianza> Configuracion del
Centro de Confianza>Configuraciéon de Macros| seleccionando una de las opciones, si los activamos
con notificacién, cuando el programa nos avise de que se ha bloquedao podremos activarlo en ese

mismo momento.

S

LR Opciones de Word

deprvacdad.

Carire ge canhanss

rihants contsen ln conliguracin de segundad y
rbiza ln segurded del eqepe. Corfiguracitn del Centoo de confiants.
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EHS O- immmn ndn 1AL 2
it ? X
NICIo INSERTAR Centro de confianza - Iniciar sesién|

o Cortar Ed i Buscar -
itores de confianza
- Calibri (Cv Configuracién de macros o peemnl
Pegar N K 3 Ubicaciones de confianza vac Resmplazar
- ¥ Copiar formato b () Deshabilitar todas las macros sin netificacién [+ Seleccionar -

Documentos de confianza - . A
Portapapeles [ (® Deshabilitar todas las macros con notificacion Edicién ~

Catalagos de aplicaciones de confianza () Deshabilitar todas las macros excepto las firmadas digitalmente
Complementos ) Habilitar todas las macros (no recomendade; pusde gjecutarse cédige posiblemente peligrese)

Configuracion de ActiveX Configuracién de la macro del programador

Configuracién de macros
[] Confiar en el acceso al modelo de objetos de proyectos de VBA

Vista protegida

Barra de mensajes

Configuracién de bloguea de archivos

Opciones de privacidad

PAGINA1DE1 5PALABRAS [

Una vez instalado el plugin, en el caso de Microsoft Word, veremos en la pestafia “Referencias” un

bloque de botones en el que aparece el simbolo de Mendeley.

DISENC DE PAGINA REFERENCIAS co

_ELI' Style: Insert a citation t.. ~ %

L Insert Bibliograph
Insert APy Export
Citation %Flefresh -

1 Mendeley Cite-O-Matic
) i 4 5 3 7 8

Para citar utilizando este plugin debemos poner el cursor en el lugar donde queremos incluir la cita y
pulsar en [Insert Citation] de forma que aparecera una pequefa ventana con una caja de busqueda para
que busquemos la referencia que queremos citar, podemos buscarla simplemente poniendo una palabra

del titulo o los apellidos del autor.
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H ©- 0 = Documentol - Ward

INICIO  INSERTAR  DISENO  DISENODEPAGINA | REFERENCIAS ~— CORRESPONDENCIA  REVISAR  VISTA Iniciar sesion

Diagegortetsr 0 1 Style [ 5 Adminstor uentes -D B 0w
D‘ Actualizar tabla Ag‘ - Ed Insert Bibliography E‘E Estilo: ] DI !
Tabla de Insertar In: Export  Insertar o - Insertar o Marcar Marcar
contenido nota al pie Citation I.—E,’ Refresh - cita - £y Bibliografia - titulo 9 entrada cita
Tabla de contenido Motas al pie & Mendeley Cite-O-Matic Citas y bibliografia Titulos indice Tabla de autoridades -~

L 3-|-2-|-L-I-E-\-1-|-2-|-3-|-4-\-5-|-G-I-i'-\-8-\-9-|-10-|-11-\12|13|14|-0-\L5|17|
~
| Insertar una cita
~
-
H - O = Documentol - Ward

INICIO  INSERTAR  DISENO  DISENODEPAGINA  REFERENCIAS ~ CORRESPONDENCIA  REVISAR  VISTA Iniciar sesiény

'@ Agregar texto - ABi ﬁ‘] Style: |Insert a citation t... - H\/ S‘,;Admlnlstrarfuents D +_F Er
! Actualizar tabla AB) - [ Insert Bibliography ER ! [ [}
Tabla de Insertar In Export  Insertar - - Insertar o Marcar Marcar
contenido - nota al pie Citation [ Refresh - cita~ £y Bibliografia - titulo 1 entrada cita
Tabla de contenido MNotas al pie & Mendeley Cite-O-Matic Citas y bibliografia Titulos indice Tabla de autoridades A

L 3‘\-2-|-L‘\-§-|-1‘ c2o0 34 5 B T B 3 e 2 12 13 e A e T
~
- Insertar una cita
i P
= open|
~ Open Access Goals Revisited: How Green and Gold Open Access Are Me *
i Sara L. Rizor; RP Holley - 2014 - Journal of Scholarly Publishing
- Abstract: ..authors ask how far the open access movement has come in me| =
™ Author Keywords: geld open access, green open access, open access, schol
N Degrees of Openness: Access Restrictions in Institutional Repositories
b Héléne Prost; J Schipfel - 2014 - D-Lib Magazine
- Abstract: ..to evaluate their degree of openness with specific attention to d
wn Global forces and local currents in Argentina’s science policy crossroads:
- Horacio Javier Etchichury; MC Pacheco - 2014 - Athenea Digital
M Abstract: ..the article describes how the Open Access movement has entere
Z Visualizing the Information of a Linked Open Data Enabled Research Infi ~
b lMy.L.lbrary ! GoTnMendeley] [ Ok ] [ Cancel
% — Accept this citation and return to editing your Word document ]
£

Podemos ir seleccionando una o varias referencias, las que necesitemos citar.

de Granda-Orive 2015;Matutinovic 2014;E=E fealieln e ls Nile il N g=i=g= o=

’My Library '] l Go To Mendeleyl | OK | \ Cancel

Al finalizar pulsamos en [OK] y Mendeley insertara la cita bibliografica en el texto, con el estilo de cita

que tengamos seleccionado.
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WGINA  REFERENCIAS CORRESPONDEMCIA REVISAR WISTA
1. ebdministrar fuentes
i 4 L stilo: apA

Export Insertar fo gifoortiy - Insurtar
v, otar titulo

salfingl |y Style/Amarican Psych... * %
. [insert Bibliography
Edit

ot &l pie + -
| SaRetresh
n

Citatios
Mendebiy Cile - Mitic

tart y Bibliogratis

“Insertar una cita con numero de pagina”(Dimey et al, 2014, p. 35)

" Insentar Tabla de ihstraciond

T Referenca cruzads
Ttulos

My Library. | B ToMendeey| [ ok || Conce

- [@GoToMendeley| | ok || concel

BGINA REFEREMCIAS CORRESPOMDENCIA REVISAR VISTA

ta al final '"3 Style: Amarican Psych_ * %
ata al ple = [insen Bibliograghy .
| SRetresh

Citation

.'-‘-/ S Administrar fuentes
L estile: APA .

Misrclefiry Citee - Math it y b

Ejemplo de una cita en la que se suprime ol nombre, cémo plantea Dimau (2014)

T Insertar Tabla de ilustrac

Referencia cruzads

Poge,

Prefix

Suffoc

¥ Suppress suthor
My Library

Editar una cita

http: / /biblioteca.uca.es

Si la cita es textual y debemos incluir el nimero de
pagina, podemos hacerlo pulsando sobre el nombre
del autor y editando los campos que nos ofrece el

programa.

No sélo podemos poner la pagina como
indicador, también hay otras opciones en el

desplegable.

La opcién [Suppress Author| sirve para suprimir el
nombre del autor de la cita, de forma que si ya en el

texto lo nombramos no lo repitamos.

En cualquier momento podemos editar una cita que hayamos incluido, sélo debemos seleccionarla y

el botén [Insert Citation] cambia a [Edit Citation] y al pulsarlo nos permite editar la cita.
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Buscar Referencias de Grupos

Si queremos buscar en las referencias de los grupos en los que estamos podemos hacerlo

seleccionandolo en el desplegable.

Dimou 2014;5earch for additional reference

[My Library 3 mGoToMendeleyl [ ok || concel

My Library
“Emotion Regulation
Grupo Pruebas Privado
Grupo Prueba Publico
Software Process

Buscar directamente en Mendeley

Si no encontramos la referencia que queremos citar con la barra de busqueda del plugin, podemos ir
directamente a Mendeley pulsando en [Go to Mendeley] y se abre el programa para que busquemos la
referencia, con dos botones nuevos en la barra superior, cuando encontremos la referencia sélo

debemos pulsar en [Cite] y volvemos al procesador de textos y se incluye la cita automaticamente.

EMondoloy Desktop
File Edit View Tools Help
F L = 1] =]

Add Files Folders Related Share

Mendeley * All Documents | Edit Settings
# Literature Search
*f B Authors Title
My Library Matutinovic, Stela Filipi Open access in botany
| = All Documents
* Recently Added . o o
) Garcia-Algar, Oscar; Vall Combel... Publicaciones cientificas: Presente y futuro
# Favorites w * 8
* My Publications
Unsorted _ @ de Granda-Orive, José Ignacio; ... El movimiento Open Access: oportunidad para re-evaluar el
proceso de revisidn por pares
.. Biblioteca
. Carpeta Prueba - Dimou, Anastasia; De Vocht, Lau.. Visualizinlg the Information of a Linked Open Data Enabled Research
' Information System
! Open Access
Create Folder... ,  Forgues, Bernard; Liarte, Sébast... Academic publishing: Past and future

Cambiar el estilo de cita
Si queremos cambiar el estilo de cita seleccionado, podemos hacerlo con el desplegable del plugin.

BH® O- Documentol - Word P EH - O %
INICIO  INSERTAR  DISENO  DISERNODEPAGINA  REFERENCIAS =~ CORRESPOMDENCIA — REVISAR  VISTA Iniciar sesién
Ty % Agregar texto + 1 G =1 Style: | American Psych... = b 5 Administrar fuentes e B F B L G
greg AB D] gl 2k i =], O =
DI Actualizar tabla Ae,‘ - = EQn: American Medical Association Pa -
Tabla de Insertar Insert American Political Science Association L Insertar E Marcar Marcar
contenido ~ nota al pie Citation E”REA — n - e fia~ titule 24 entrada cita
Tabla de contenido Notas al pie Mey American Psychological Association 6th edition Titulos fndice  Tabla de autoridades ~
American Seciclegical Association
L 3 2 1 E 1 2 X o 12 3 14 o 16 17
Chicage Manual of Style 16th edition (author-date)
Chicage Manual of Style 16th edition (note)
~ Harvard Reference format 1 (author-date)
IEEE
- 150-690 (author-date, Spanish)
Modern Language Association 6th edition (note)
More Styles...
- 'nsertar una cita(Rizor & Holley, 2014)
~
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De esta misma forma podemos ir incluyendo todas las citas necesarias en nuestro trabajo.
Insertar el Listado bibliografico

Cuando queramos incluir el listado de la bibliografia utilizada, sélo tenemos que pulsar en [Insert
Bibliography]

Si hacemos cambios en las citas, el programa cambia automaticamente el listado bibliografico cuando

los detecte, si queremos forzar el cambio podemos pulsar en [Refresh].

B EH S :
INICIO  INSERTAR  DISENO  DISENODEPAGINA  REFERENCIAS ~ CORRESPONDENCIA — REVISAR  VISTA Iniciar sesién
B~ ABl M %# 1 i - % @ = Administrar fuentes B D B 'Er &
) AR ~ = | EQinsert Bibliography - ER Estilo: |APA - '
Tabla de Insertar Insert Export Insertar = . Insertar e Marcar Marcar
contenido nota al pie Citation & Refresh - cita- EyBibliografia v titulo 2 entrada cita
Tabla de contenido Motas al pie Mendeley Cite-O-Matic Citas y bibliografia Titulos indice Tabla de autorida...
L 3 2 i g 1 2 3 4 5 6 7 ] 3 10 ii i2 i3 i4 & 16 17

Insertar una cita(Rizor & Holley, 2014) otra cita de ejemplo(Dimeou et al., 2014} una ultima para
la prueba(Lépez-Torres Hidalgo, 2011)

Dimou, A., De Vocht, L, Van Grootel, G., Van Campe, L, Latour, J., Mannens, E., & Van de
Walle, R. (2014). Visualizing the Information of a Linked Open Data Enabled Research
Information System. Procedia Computer Science, 33, 245-252.
http://doi.org/10.1016/j.procs.2014.06.039

Lopez-Torres Hidalgo, J. (2011). Habitos de lectura de revistas cientificas en los médicos de
Atencién Primaria. Atencion Primaria, 43(12), 636—637.
http://doi.org/10.1016/j.aprim.2011.07.005

Rizor, 5. L., & Holley, R. P. (2014). Open Access Goals Revisited: How Green and Gold Open
Access Are Meeting (or Not) Their Original Goals. Journal of Scholarly Publishing, 45(4),
321-335. http://doi.org/10.3138/jsp.45.4.01

10
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Coémo incluir las citas en Nota al Pie

Para incluir citas en nota al pie, debemos llevar a cabo dos pasos:

- Crear la nota al pie en el procesador de textos.

- Incluir la cita en la nota al pie, con el plugin de Mendeley, de la misma forma que hemos visto pero

seleccionando un formato de cita completa en el texto como: Chicago (full note), Turabian (full note) o

MLA (note)

INICIO  INSERTAR DISERC  DISENIO DE PAGINA - REFERENCIAS CORRESPONDENCIA REVISAR  VISTA

Documentod - Ward T - >'

Iniciar sesian 8

AB' enrtar ke ol i m} style: Chicago Manual. BTR [, Shadministrar fusntes Iresertar Tabila de ilustracio +_'- +_r 3
A% Siguiente natas al pe - Elin: American Med on -
Takla de Inzertar Inzert SR ciation Mancar Marear
contenide - nota al pie [ Mostrar notas Citation N »ia cruzada entrada <ita
cal Asscciation 6th edition 3
= c 4 il Indico abla de autcridaces ~
: Amernican Seciological Assoc i~ 17
1 = ‘ 2 x Chicage Manual of Style 15th edit T 13 : 1 .
Chicago Manual of Style 16th edis
Chicage Manual of Style 16th edition (note)
a Harvard Reference format 1 [authar-date]
IEEE
Modern Humanities Research Association 3rd edition (note with bibliography)
Ix Mare Styles
1K Antelman, «Do open-access articles have a greater research impact?», College & research libraries,
A 2004,
2 bid.
a
L
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LibreOffice

En el caso de LibreOffice, la utilizacion del plugin es igual a Word, una vez instalado [Tools>Install

LibreOffice Plugin] la barra aparece automaticamente arriba de la barra de edicién de texto.

B

"

hio Edis

car oo Eoilos 1ol

Universidad
de Cadiz

Area de Biblioteca

Sin titulo 1 - LibreOffice Writer

o i

 alnsert Citation | ¢ Undo Edit Merge Citations [[[] Insert Bibliography  43) Refresh  Choose Citation Style  Export MS Word Compatible

e ‘]Inqenfix?l‘ial @ [ f Moy aaqaa aba, I 2' P
5 - S S WY L ST T
Iba yo un dia por el campo caminando, como dijo Schopenhauer
o Mendeley Citation Editor iy - |
|
My Libeary ~ | [ENcoTovendeiey [ 0% Cancel
Pégina 1 de 1 11 palabras, | Espaitol (Espaiia) | -

-|| o=

=

1]

il
il
lil o

BO0 M | - ——0

http: / /biblioteca.uca.es

@

+ | 100%

Sila barra no apareciera, se debe mirar si la barra esta activada en [Ver>Barras de herramientas>
Mendeley]

B

Archivo  Editar

{9y Insert Citg

i Estilo predeter

L

v

=

=A

< g

eoR®s

s

Sin titulo 1 - LibreOffice

Insertar Formato Estilos Tabla Hemamientas Ventana Ayuda

Normal

Web

Barras de hemamientas »
Barra de estado

Beglas »
Barras de desplazamiento .

Limites del texto
Limites de la tabla

Imégenes y diagramas

Comentarios

Caracteres no imprimibles Ctrl<F10
Cusdricula y lineas de sjuste -

Ocultar espacios en blanco

Marcas CtrieF8

Nombres de campo CtrleF9

Pérrafos prultos

Estado del método de entrads

Barra lateral

Estilos y formato 3]

Galenia

Nayegador F5

Crigenes de datos F4
» Pantalla completa  Ctrl+ Maytis+]

Escala B

Insert Bibliography ’ﬁnencsn Choose Citation Style  Export b

Alinear objetos
Buscar
Configuracion 30
Controles de formularic
Dibujo
Disefio de formularios:
Editar puntos
v Esténdar
Esténdar (modo de visualizacion)
Fontwork
¥ Formato
Herramientas
Imagen
Insertar
Logo
Maree
¥ Mendeley
Navegacion
Mavegacitn en formularios
Numeracién y vifietas
Objeto de testo
Objeto OLE
Propiedades del abjeto de dibujo
Reproduccién multimedia
Sequimiento de cambios
Tabla
Fe Fomula

Personalizar...
Restablecer

I a-

o

jo Schopenhauer
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Integracion con LaTeX

Mendeley permite la integraciéon con el procesador de textos LaTeX, para ello debemos pulsar en
[Tools>Options] e ir a la pestafia [BibTex] en ella podemos sincronizar BibTex.
Mais informacion sobre la integracion con LaTeX en:

[http://blog.mendeley.com/tipstricks/howto-use-mendeley-to-create-citations-using-latex-and-bibtex/]

m Options ’TE

| General | Document Details | File Organizer Watched Folders BibTeX Zotero | Connection |

BibTeX Export Preferences

¥ Escape LaTeX special characters (#{}%#& etc.}

Use Journal Abbreviations

BibTeX Syncing

BibTeX syncing keeps one or several BibTeX files up to date with the documents in your library. Documents in the
'Needs Review' collection will not be exported.

¥ Enable BibTeX syncing
@ Create one BibTeX file for my whole library
Create one BibTeX file per collection

Create one BibTeX file per document

Path: \\psfiHome\Documents . Browse...

Citation Keys

Citation keys for documents are automatically generated in the format [AuthorYear]. To edit citation keys
manually, enable the 'Citation Key' field on the Document Details tab

| OK | Cancel Apply

Grupos de Trabajo Publicos y Privados

Mendeley permite crear grupos de trabajo tanto publicos como privados para compartir referencias.
Buscar Grupos de Trabajo Publicos

Si queremos localizar grupos de trabajo publicos sobre nuestros temas de interés para contactar con
otros investigadores que trabajen en nuestra area y compartir referencias y comunicarnos con ellos,

podemos hacerlo a través de la busqueda o los listados por disciplinas en la plataforma web de

Mendeley, marcando la pestafia [Groups| del buscador.
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M Feed Library Suggest Stats Groups Data g BcaCPR . v
Papers Peop\uppor{

@, Software Process Improvement]|

Groups

In this catalog: 184,878 pubiic groups Create a new group

Software Process Improvement m

eg: Social networks

Groups 1 - 20 of 1,146 Preva 12 3 58 » MNext

Data in Instructional Improvement Planning Process
Use of data fo inform on the Instructional Improvement Planning Process, K-12

H Ask tojoin group 5y Follow group 37 papers - 1 member

Team Software Process
©On the use of the Software Engineering Institute’s Team Software Process, “straight’
or blended with agile, CMMI, Six Sigma, ...

iy Ask tojoin group Sy Follow group 12 papers 2 members

. Software Process Improvement & Formal Methods
- M Grupo de investigacin TIC-195, Universidad de Cadiz

-
% Ask tojoin group  8) Unfollow group 41 papers - 7 members

Incorporarse o seguir a un grupo de trabajo publico
Cuando encontramos un grupo que nos interese podemos seguirlo pulsando en [Follow this group] o
intentar unirnos al grupo como miembros, en [Join this Group] si el grupo es abierto y en [Ask join this

group] si al grupo solo se puede acceder con invitacion.

M Feed Library Suggest Stats Groups Q, Search BcaCPR ~ v

-~ Software Process Improvement & Formal Methods

B M In this group: 41 papers - 7/25 members

Follow this group

\ I Ask to join this group

‘ Mendeley | Computer and Information Science |+ Groups
| Overview
Group activity About this group
Papers

flepbes . Juan Manuel Dodero added documents to this group g;';r;i?a?g;ﬁgggpue' Dodero

3 Aplicacion de Recomendaciones para la Alineacion de
= Computer and Information Science

Competencias, Metodologia y Evaluacion en Asignaturas de
Ingenieria Telemética, Informética y Electrdnica

|- Assessment of collaborative learning experiences by graphical Grupo de investigacin TIC-195, Universidad
analysis of wiki contributions ..
de Cadiz
|2 Design of learning activities to access web-based thematic
dynamic resources @ spi-fm.uca.es
15th July, 2014
& members

Juan Manuel Dodero added a document to this group i . 1 - |
) Model-Criven Learning Design - oa \F‘.‘, s E N
22nd January, 2013

‘Computer and Information Science

Juan Manuel Dodero added documents to this group
|-% Aplicacion de Recomendaciones para |a Alineacion de Aslto join this group

Competencias, Metodologia y Evaluacién en Asignaturas de
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Crear un Grupo
Si deseamos crear un grupo, podemos hacerlo desde Mendeley Desktop pulsando en [Create Group], se
nos solicita que pongamos un nombre y una descripcién al grupo y que seleccionemos una de las

modalidades: Private, Invite-Only u Open.

Mendeley Desktop

|] File Edit View Tools Create a new group
| | T | [ L=
Add Files Folders
Mendeley

+— Literature Search
L Mendeley Suggest

My Library
=l Al Documents
& Recently Added
7.7 Favorites Group Type @ @ Private

share

__g:, My Publications
[l Unsorted
4 ||| Carpeta Prueba
|| Subcarpeta
|| Open Access
Create Folder..,

Open

are referenc

Groups
|E Grupo Pruebas Privado
L& Grupo Prueba Publico :

%/ Emotion Regulation | Cancel | Create group |
Create Group...

Una vez creado, o cuando somos parte de un grupo, al pulsar en el nombre del grupo, veremos que
tenemos varias pestafias en las que podemos interactuar con mensajes de texto con los demis
miembros del grupo, asi como ver las novedades, los cambios realizados en el grupo, compartir
bibliograffa (para incluir bibliografia a un grupo sélo debemos arrastrar y soltar, como en las carpetas) y

ver los miembros del grupo.
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i T
Mendeley Desktop [= @] =5
File  Edit Tools  Help
Gir &) el =2 el
Add Files Folders Related  Share Sync. Search
Meleley 25 Process Imp & Formal owned by Juan Manuel Dodera

4~ Literature Search

Overview ‘ Documents | Members. |

L Mendeley Suggest

My Library

Ask a question or comment here ‘
=l All Documents
\\5 Recently Added
“pi Favorites

_?_ My Publications

Juan Manuel Dodero added decuments to this group

|5 Aplicacién de Recomendaciones para la Alineacién de Competencias,
Metodologia y Evaluacién en Asignaturas de Ingenieria Telemdtica, Informatica
y Electrénica

(7 Unsorted i
|55 Assessment of collaborative learning experiences by graphical analysis of wiki
4 L Carpeta Prusba contributions
(L subcarpeta |- Design of learning activities to access web-based thematic dynamic resources
{1l apen Access 7 membe

Like + Comment « 15th July, 2014
Create Folder...

Juan Manuel Dodero added 3 document te this group
Groups

E Grupo Pruebas Privado
L& Grupa Prusba Publico
=) Emotion Regulation

5% Medel-Driven Learning Design

Like « Comment . 22nd January, 2013

Juan Manuel Dodero added documents to this group
ﬂ'_. Software Process Improveme...

|5 Aplicacién de Recomendaciones para la Alineacién de Competencias,
Metadologia y Evaluacion en Asignaturas de Ingenieria Telemdtica, Informatica
y Electrénica

Create Group...

Trash I_;* Assessment of collaborative learning experiences by graphical analysis of wiki

- contributions
|2 Al Deleted Documents - s . . . .
|54 Design of learning activities to access web-based thematic dynamic resources

L <> Embed
Filter by Authors v] - |5 El proyecto ASCETA: una experiencia de colaboracién universidad-empresa en
Al D investigacion y desarrollo
Alonso, José-Antonio ;_; Model-Driven Learning Design
A -Pérez, J. L.
B:::‘l:': L::: Like . Comment - 4th December, 2012

Anotaciones en Grupos
Los subrayados y anotaciones en los grupos se comparten siempre que sean realizadas abriendo el
documento desde el espacio del grupo, no las realizadas en el espacio personal, y sélo en los grupos

privados. Los subrayados aparecen en diferentes colores para identificar a los diferentes usuarios.

2 My Library ® The rode of catalyst in su... O

——— — = - - — = —
the bulk and surface properties of fresh and SCW-exposed catalysts for treatment of the HS-HD model
system using X-ray diffraction (XRD), scanning electron microscopy (SEM), and X-ray photoelectron
spectrometry (XPS). As anticipated, Mo5; remained unchanged during the SCW treatment, whereas MoQy
and ZnO underwent structural and morphological changes primarily related to sulfidation reactions. The
results of this work help establish the role of catalysts in the SOW process; demonstrate that modest
desulfurization can be achieved in the absence of an external hydrogen source; and provide guidelines
for catalyst selection.

@ 2013 Elsevier BV, All rights reserved.

1. Introduction desulfurization (OEDS) [9-11], adsorption desulfurization (ADS)

[12-16] and bio-desulfurization (BDS) [ 17-19]. None of the options

The removal of sulfur-containing compounds from crude oil is to HDS has been proven economically viable at commercial scales,

1P due dy increasesin the sulfur content motivating continued efforts to identify hydrogen free methods to
of remaining petroleum resources and mounting environmental reduce sulfur content.

concerns associated with SOx emissions, The primary sulfur

| 1 is hyd Ifurization (HDS), a process that has

long been used at the refinery level [1-3]. Refining high sulfur

feeds to meet inc sulfurreq has placed
stress on the performance of HDS, especially due to the costs of the
large frequired hyd; For this reason, hydrogen-free

sulfur removal processes have received substantial interest in the
last decade |4]. Hydrogen-free sulfur removal methods include
oxidation desulfurization (ODS) [5-8|. oxidation-extraction

COncentration, and catalysts [32]. SCW has a viscosity compara-
E-mail addresses: ates@cumburiyet.edutr (A, Ates). gazimi@mit.edu b:f .mlf' ga: “}.'1h|ch acce]eradtesu transfer plmcesses ml%“‘;f. tﬁ

(G. Azimi), kihyouk choi@arameo.corn (K.-H. Choi), whgreen@mit.edu (WH, Green),  Lnelf liquid phase rates and allows some catalysts to retain hig

timkoO7@gmail.com (M.T, Timko). activity for extended periods of time [25,32.33]. However, SCW is a

* Corresponding author, Tel.: +1 6172534580; fax: +1 6172588992,

0926-3373/5 - see front matter © 2013 Elsevier BV, All rights reserved,
hitp://dx.doi.org/10.1016/j.apcatb. 201 3.08.018
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Mendeley como Red Social de Investigadores

Perfil Publico de Investigador en Mendeley

Mendeley permite tener un perfil publico como investigador.

M Feed Library Suggest Stats Groups Q, Search BecaCPR . ~

Juan Manuel Dodero R

Publications Readers

Associate Professor

Universidad de Cadiz - University of Cadiz

Following Message &
Followers (66) Publications All (67) v
Alejandro Al A Fall o . . . .
“ Ganere R TS A Domain Specific Language for Online Learning Competence
Conseil Européen pou...

Assessments

Andrea Calderan M... Follow +9,
Balderas A, Dodero J, Palomo-Duarte M
! University of Cadiz
International Journal of Engineering Education (2015)
Anke Berns Follow +9,
- s fe 1 Readers
University of Cadiz + Save reference
‘. Anke Berns Follow +Q
Universidad de Cadiz ...
About Didactic Transposition: Teaching programming
BcaCPR Universida... .
~ fundamentals at different levels of the school system
Universidad de Cadiz ...
Insuasti J, Dodero J
LATICE (2015)
Explore network >
+ Savereference A Get full text at journa == Readers

Following (66)
Andlisis de interaccién en entornos virtuales orientados al
l Juan Carlos Ferndn... Follow +9, aprendizaje de idiomas Analysis of students ' interaction in
Universidad Antonio d... : ) ) i ) )
virtual environments designed for foreign language learning

i o
Daniel Burgos Fallow +2, Duarte M, Berns A, Dodero J, Ruiz-rube |

-

Save reference 1 Readers
Antonio Balderas A... Follow +© +

-

i i o
Javier Luis Canovas... Follow +9

Universidad Abierta d... Experiences of technology-rich innovation in European

schools within the Open Discovery Space project Experiencias
z Francisco Tena Follow +9, . ., .
SAES de innovacién tecnoldgica en las escuelas europeas del
proyecto Open Discovery Space Resumen Key‘words - Palabras
Explore network > Clave :

Peinado S, Mota |, Palome-duarte M, Dodero |, Martellos S, Doran R, et al.

+ Save reference 3 Readers

En este perfil podemos incluir nuestros datos de contacto, intereses, formacién o experiencia laboral,
informacion que se incluye en la plataforma web de Mendeley, pulsando en [Nombre de usuario>Edit

en cada campo]
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M Feed Library Suggest Stats Groups Q, Search BcaCPR v

BcaCPR Universidad de
Cadiz # =t

University Library g* Edit
Library g° Edit
Universidad de Cadiz - University of Cadiz 4* Edit

Update profile About  Edit

90% complete
Biblioteca del Campus de Puerto Real

Universidad de Cadiz
Spain

+/ Add your photo complete
Edificio Biblioteca de Campus (more)

+/ Add your research interests complete

Por otra parte, si también queremos que aparezcan en nuestro perfil nuestras publicaciones, debemos

incluir las referencias de las mismas en la carpeta [My Publications| de Mendeley.

NOTA: Al incluir una referencia en la carpeta [My Publications] Mendeley nos pregunta sobre la

autoria de la referencia.

My Publications ? >

[ agree that:

I am an author of these documents

[ ] Do not ask me again I agree Cancel
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Contactos: Seguir a otros Investigadores

Mendeley, ademas de ser un gestor de referencias, pretende ser una red social para investigadores, para
ello, ademas de los grupos publicos y los perfiles, también permite seguir a otros investigadores para
contactar con ellos. Para localizar a investigadores a los que nos pueda interesar seguir, debemos ir a la

pestafia [People] de la web de Mendeley.

En esta pestana podemos localizar a otros investigadores buscando por nombre, cuando lo localicemos,

veremos su perfil y podremos pulsar en [Follow| para seguitlo o enviarle un mensaje en [Send Message]

M Feed Library Suggest Stats Groups BecaCPR . v
Paper roups Support

Q, Palomo Duarte

People

m Search to connect with other people you know or ofher

palomo duarte

researchers in your field.

eq: Vicior Henning

Prev4 1 2 3 .82 » Next

Falomo-Duarte Manuel .
1 Associate Professor Follow &

Gabriela Palomo .
Student (Master) Follow 2
Encargada de las Colecciones de Referencia
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Opciones de Configuracion de cuenta

Podemos configurar nuestra cuenta en la opciéon [Imagen de perfil >Settings] donde podemos

configurar temas como la privacidad y las notificaciones.

m Feed Library Suggest Stats Groups Q, Search icaCI"R@
‘ Sebtings
l hexount

: Account i
Privacy :
Motification Chaing .  Bocount sett ; I EL A il PPt

otifications Changing your basic sccount settings here will change it in all Elsevier products Learn mo
Billing Logout

l@ucls  Change your passwar
First mame
BeaCPR

Last name
Universidad de Cidiz

Academic Status

Librarian 'd
Discipline
Social Sciences |

Opciones de Gestion de Documentos

Si queremos que Mendeley gestione nuestros documentos en el ordenador de forma automatica,
podemos configurar esta opcién en [Tools>Options], de forma que cada PDF que incluyamos en
Mendeley el programa lo alojard en la carpeta que le digamos, ordenados en subcarpetas segin

seleccionemos y renombrados de la forma que prefiramos.

r Options | ? & .|1

| General | DocumentDetails | File Organizer | WatchedFolders | BibTex | zotero | connection |

Crganize my files

Copy files to:  C:\Users\TGRI2\Documents\Mendeley Desktop Browse... Tidy Up

Open folder in Windows Explorer

Sort files into subfolders

Unused fields: | | :Year: ) :jﬁﬂe: ) :Journal: ) ‘

Drag bubbles down to add or up to remove.

Folder path: ;Auﬁ'mr: )

Example: C:\Users\TGRIZ\Documents\Mendeley Desktop\Author!,

Rename document files

Unused fields: .ﬁﬂe:. .Joumal:. ‘

Drag bubbles down to add or up to remove. Hyphen-separated -
File name: ;Auﬁ'mr: ) o :Year: )
Example: Author - Year.pdf

s
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Mendeley en Plataforma Web, tu Biblioteca

La plataforma web de Mendeley cuenta con una réplica online del programa instalable a la que
podemos acceder desde la web de Mendeley en la pestana [Library], de forma que si alguna vez no

estamos en nuestro ordenador y no podemos instalar el programa, pero queremos acceder a nuestras

referencias, podamos hacerlo sin problemas.

M Feed Suggest Stats Groups Q, Search BcaCPR ~ ~

SR, MENDELEY
MY LIBRARY O | g&l Addto | [ Delete 1= Added (newest) Details Notes
) [P oS o & Performance analysis & energy benefits of a desiccant based solar assisted trigeneration syst.. . o / Edit =
Hands S, Sethuvenkatraman S, Peristy M, et. al. in Renewable Energy (2016) [ Journal Article
% Favorites Understanding the generation of
o & Study on Demand-side Design Parameters of Solar Domestic Honbbhjhjhjhstem in Residential - thanol thesi d wat
= My Publications Chen X, Hao B, Liu S, et. al. in Energy Procedia (2015) o methanol synthesis and water gas
shift activity over copper-based
I Recently Read Nitrate and trace elements in municipal and bottled water in Spain talysts — A tiall Ived
o ) T : e catalysts — A spatially resolve
Espejo-Herrera N, Kogevinas M, Castaiio-Vinyals G, et. al in Gaceta sanitaria / SE S P.AS (2013) N N . B
FOLDERS experimental kinetic study using
+ Create Folder Understanding the generation of methanol synthesis and water gas shift activity over copper-b . steady and non-steady state
Wikinson S, van de Water L, Miller B, et. al. in Journal of Catalysis (2016) L operation under CO/CO2/H2 feeds
» @ Carpeta Prueba
o Measurement of the Rate of v e+ d— p+ p+ e— Interactions Produced by B 8 Solar Neutrinos a . Wilkinson S, van de Water L, Miller B
M Open Access in Physical Review Lefters (2001) T Simmons M, Stitt E, Watson M
o & Ozone in water treatment: application and engineering . Journal of Catalysis
Res F, Langlais B (1991) [ar 2016 vol: 337 pp: 208-220
o & S;ge:r;uard methods for the examination of water and wastewater i Understanding the mechanism and generation of
' ! activity for methanol synthesis and the water gas
Las necesidades de agua de los cultivosGuidelines for predicting crop water requirements . st TEECtIO.ns l:.ver :opper—l:asted c;talysts
m] oorenbos 1. Aboukhaied W (1577 7 Mar || remains a significant area of study in
heterogeneous catalysis. In this work, steady
o a Standard methods for the examination of water and wastewater . CrHMy Ty SR T ) T
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- ; ; more ¥
GROUPS 5 Characterization of N-Acylhomoserine Lactones Produced by Bacteria Isolated from Industrial ..
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DOl 10.1016/j jcat. 2016.01.025
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Copias de seguridad

Si queremos hacer una copia de seguridad de nuestra biblioteca de referencias, se puede hacer
simplemente pulsando en [Help>Create Backup] de la misma forma, podemos restaurar una copia de

seguridad pulsando en [Help>Restore Backup]

Exportar a otros gestores

Si queremos exportar nuestras referencias a otro gestor, s6lo debemos seleccionar las referencias a
exportar, pulsar en [File>Export] y elegir un formato compatible con el gestor donde vayamos a

importarlas.
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Aplicacion Mendeley para iPad/iPhone/Android

Mendeley tiene también aplicaciones para 1OS (iPad y iPhone) y Android.

iPad / iPhone: | https://itunes.apple.com/gb/app/mendeley-reference-manager/id380669300?mt=8 |

Android: [ https://play.google.com/store/apps/details?id=com.mendelev&hl=es |

La principal funcionalidad de las aplicaciones méviles de Mendeley es la lectura, subrayado y anotacion
de los documentos, de forma que podamos leer mas comodamente utilizando un dispositivo mévil.
Esos subrayados y notas se sincronizan con la versiéon online y la version para ordenador si trabajamos

con la misma cuenta.

A balance of protein

y and
dependent degradation
determines the
maintenance of LTP.

Cataiog IDs
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Take your library anywhere
with Mendeley for Android.
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Cerrar la Sesion

Si estamos en un ordenador publico, no debemos olvidar cerrar la sesion en Mendeley Desktop

pulsando en [File>Sign Out| y en la plataforma web en [Imagen del perfil >Logout]

E Mendeley Desktop
- Edit View Tools Help Q, Search BcaCPR
Add Files... Ctrl+O
Add Folder.. Ctrl+Shift+O .
Watch Folder.. Settings
Add Entry Manually... Inst Privacy
Import... 4
Export... Ctrl+E The \ Download Mendeley
Send by E-mail... :
Merge Documents impec Support

Delete Documents docu
Remove from Folder acad Logout

Rename Document Files...

onize Library F5

. . + Add it to your browser
Sign Out (biblioteca.puertoreal@uca.es)

)

Ctrl+Q
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Mas Informacion

Web sobre gestores de referencias de la Biblioteca:

http://biblioteca.uca.cs/gestores-de-referencias-bibliograficas/mendeley/

En esta web se puede descargar esta guia y el guion para el seguimiento de la explicacion en los cursos

en formato PDF.

Videotutorial sobre como Migrar de RefWorks a Mendeley:
https://www.youtube.com/watch?v=V7jCL.:MZqQY

Guias de formacion oficiales en Inglés: http://community.mendeley.com/guides

Canal en YouTube de Mendeley: http://www.voutube.com/user/MendeleyResearch/

Jests Fernandez Garcia

Técnico de Gestion de Recursos de Informacion

Biblioteca Campus de Puerto Real, Universidad de Cadiz

Web: http://biblioteca.uca.es /e-mail: jesus.fernandez@uca.es / TIf: 956 01 63 04

Material Complementatio a la Formacién de Usuarios. / Biblioteca de la Universidad de Cadiz

@00

Esta obra se comparte bajo la licencia:
Creative Commons Reconocimiento-NoComercial-Compartirlgual 4.0 Internacional.

http://creativecommons.org/licenses/by-nc-sa/4.0/deed.es ES
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